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Prólogo 
 
 
Este manual ha sido creado por Hologic®, Inc. Tiene el objetivo de guiar al usuario durante la configuración, la instalación y el 
uso del hardware Faxitron Path, así como del sistema de software Vision, ambos desarrollados por Hologic® Inc. 
 
Faxitron Path anteriormente recibía el nombre PathVision 
 
El usuario deberá configurar primero el hardware y, a continuación, iniciar el software Vision. Antes de continuar, revise los 
procedimientos de configuración obligatorios incluidos en la segunda parte de este manual. 
 
 
 
Indicaciones de uso 
 
El sistema Faxitron Path es un armario de rayos X que se utiliza para obtener imágenes de rayos X de película o digitales de 
especímenes procedentes de varias regiones anatómicas con el fin de verificar rápidamente que durante la biopsia se haya 
extirpado el tejido correcto. Realizar la verificación directamente en la misma sala o en sus proximidades permite que los 
casos se concluyan más rápidamente, limitando así el tiempo necesario para explorar al paciente. La radiografía de los 
especímenes puede limitar potencialmente el número de citas para los pacientes. 
 
Uso con receta médica (parte 21 CFR 801, subparte D) 
 
Precaución: De acuerdo con la legislación federal, la venta de este instrumento queda restringida a los médicos o por 
prescripción de los mismos. 
 
 
El sistema puede funcionar como un dispositivo autónomo. Si se conecta a una red, es fundamental que se implementen 
medidas para reducir el riesgo para los pacientes disminuyendo la probabilidad de que la funcionalidad del dispositivo se vea 
comprometida, intencionada o involuntariamente, por una ciberseguridad inadecuada. 

 
www.hologic.com/package-inserts 

 

http://www.hologic.com/package-inserts
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Este manual ha sido creado por Hologic, Inc. Tiene el objetivo de guiar al usuario avanzado 
durante la configuración, la instalación y el uso del hardware Faxitron Path, así como del 
software Vision, ambos desarrollados por Hologic, Inc. 
 
Antes de utilizar el sistema, lea atentamente toda esta información. Siga todas las 
advertencias y precauciones indicadas en este manual. Tenga este manual a mano durante 
los procedimientos. Siga siempre todas las instrucciones de este manual. Hologic, Inc. no 
asume la responsabilidad de las lesiones o los daños derivados de un uso incorrecto del 
sistema. Hologic puede organizar un curso de formación en su centro. 
 
Gracias de parte de todos los que integramos Hologic, Inc. 
 
Fabricante e información de contacto 
 

 
 
 

Hologic, Inc. 
36 Apple Ridge Road 
Danbury, CT 06810 EE. UU. 
1.800.447.1856 
www.hologic.com 
 

 
 
PATROCINADOR DE AUSTRALIA 
Hologic (Australia and New Zealand) Pty Ltd 
Suite 302, Level 3 
2 Lyon Park Road 
Macquarie Park NSW 2113 
Tel.: 02 9888 8000 
 

 
 
Hologic, BV 
Da Vincilaan 5 
1930 Zaventem 
Bélgica 
Tel.: +32 2 711 46 80 
Fax: +32 2 725 20 87 
 

 

 

 1.0.0 
Introducción 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

En este manual y en el sistema de ayuda en línea, se utilizan los siguientes símbolos: 
 

 
Advierte al lector de una posible electrocución en caso de que ignore la 
advertencia y utilice deliberadamente herramientas específicas para abrir un 
armario eléctrico precintado y manipular su contenido. Nota: Hologic, Inc. no 
proporciona ninguna herramienta. 

 
 
Advierte al lector de una situación de peligro. Por lo general, este símbolo va 
acompañado de un símbolo más específico y de las instrucciones pertinentes 
en cuanto a la naturaleza del peligro, el resultado esperado del peligro y la 
información para evitarlo. 
 

 
Advierte al lector de que debe tener cuidado al levantar equipos pesados para 
evitar generar lesiones corporales y daños al equipo. 
 
 
Advierte al lector de que en el área etiquetada se emite una radiación ionizada 
cuando el haz de rayos X está bajo tensión. El sistema Faxitron Path dispone 
de enclavamientos de seguridad que evitan que se acceda a la zona etiquetada 
mientras el haz de rayos X está bajo tensión. 

 
Advierte al lector que utilice la protección adecuada (como guantes quirúrgicos o 
un recipiente autorizado para especímenes) con el fin de evitar la exposición a 
materiales potencialmente infecciosos, como las muestras de tejidos del paciente. 

 1.1.0 
Símbolos de 
advertencia y 
precaución 
incluidos en este 
manual 

 
 

 

http://www.hologic.com/
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Símbolo Descripción 

 
"ENCENDIDO" para parte del aparato 

 

Terminal de ecualización de potencial 

 

Para desecharlos, separe los dispositivos eléctricos 
y electrónicos de los desechos normales. Envíe el 
material desmantelado a Hologic o contacte con su 
representante de atención al cliente. 

 

Fabricante 

 

Fecha de fabricación 

o  

Precaución — Radiación (se generan rayos X) 

 

Precaución — Materiales potencialmente 
infecciosos 

 

Advertencia sobre electricidad 

 

Precaución 

 o  

Siga o consulte las instrucciones de uso 

 

Este sistema transmite energía de radiofrecuencia 
(RF) (radiación no ionizante) 

 
Representante autorizado europeo 

 Producto sanitario 

 
Número de catálogo 

 
Número de serie 

 

 
 
 

1.1.1 
Símbolos de 
advertencia y 
precaución  
en las etiquetas 
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Instalación y configuración 
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Advertencias 
• Antes de utilizar el sistema, lea atentamente las instrucciones. 

• No utilice el sistema de manera distinta a la del uso previsto, tal y como se describe en 
este manual. En caso de duda, póngase en contacto con Hologic o con el distribuidor 
autorizado. 

• No todos los cables de alimentación tienen la misma clasificación. No utilice con este 
sistema ningún otro cable de alimentación que no sea el suministrado. No utilice el cable 
de alimentación de este sistema en ningún otro equipo. 

• Este sistema ha sido probado siguiendo las normas internacionales más estrictas; no 
obstante, en lo relativo a los requisitos operativos locales es recomendable que se ponga 
en contacto con las autoridades nacionales. 

• Este sistema no está destinado al uso público. Deberá estar situado en una zona en la 
que el público en general no pueda acceder al sistema sin la presencia de un operador. 

Precauciones generales 
Para evitar producir daños al sistema Path, deberán tomarse las siguientes precauciones: 

• Mientras el sistema esté encendido, nunca conecte ni desconecte los cables de 
comunicación y/o alimentación. Si los cables se conectan o desconectan mientras la 
cámara está encendida, podrán producirse daños en el sensor CMOS o en los 
componentes electrónicos de la cámara. 

• El sistema de cámara es frágil y se debe tener cuidado para no dañarlo. El sistema de 
cámara nunca se deberá manipular incorrectamente, golpear bruscamente, golpetear ni 
dejar caer. 

• El sistema Path dispone de un modo de calibración. Para garantizar el correcto 
funcionamiento del sistema, la calibración deberá llevarse a cabo diariamente. Consulte el 
Procedimiento de calibración. 

• Precaución: el uso de controles o los ajustes para realizar procedimientos distintos de los 
especificados en el presente documento podrá provocar la exposición peligrosa a la 
radiación. 

Conexiones interoperativas 
El Path es capaz de funcionar como un dispositivo autónomo, sin entradas ni salidas hacia 
otros dispositivos. En el sistema, las imágenes se pueden captar, almacenar y revisar 
directamente.  

Sin embargo, el sistema dispone de varias interfaces. La principal es la conexión de red 
que permite conectar el sistema a un Sistema de archivo y comunicación de imágenes 
(SACI). Las imágenes pueden ser transmitidas en formato DICOM desde el dispositivo 
directamente a la red del centro a través de nuestro software. Para obtener más detalles 
sobre la versión de DICOM, consulte la sección 6. Solamente deberán configurar esta 
comunicación los empleados de Hologic o el personal de TI capacitado del centro del 
usuario. 

A continuación, se enumeran las conexiones del sistema y el uso previsto. Ningún otro tipo 
de dispositivo deberá conectarse al Path sin la aprobación de Hologic. 

 

 

 

 

 

 
 

 2.1.0 
Advertencias y 
precauciones del 
sistema 
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Conexión Propósito Tipo de dispositivo Usuarios a los que va dirigido 
Puerto 
Ethernet de la 
parte posterior  

Almacenar imágenes radiográficas en un 
sistema de almacenamiento de datos en 
red. 

SACI o 
almacenamiento en 
red 

Configurado por el personal de 
Hologic o de TI del centro. 
Utilizado por profesionales clínicos. 

Puerto 
Ethernet de la 
parte posterior 

Permitir la conexión remota por parte del 
equipo de mantenimiento de Hologic 
para que Hologic pueda diagnosticar y 
reparar el sistema. 

Conexión a Internet 
en red 

Personal de Hologic o de TI del 
centro. 

Puerto USB de 
la parte frontal 

Transferir imágenes desde el dispositivo. 
Este solamente se deberá utilizar si el 
SACI o la red no están disponibles.  

Dispositivo de 
almacenamiento 
USB (memoria flash) 

Profesionales clínicos o de TI que 
tenga acceso autorizado al sistema.  

Puerto USB de 
la parte frontal 

Mantener y conservar los archivos del 
sistema; es posible que sea necesario 
copiarlos en y desde el ordenador. Por 
ejemplo, actualizaciones de software o 
archivos de registro.  

Dispositivo de 
almacenamiento 
USB (memoria flash) 

Personal de Hologic o de TI del 
centro. 

Puerto USB de 
la parte 
posterior 

Permitir la conexión de una impresora. El 
software Vision permite la conexión de 
una impresora DICOM o una impresora 
estándar compatible con Windows.  

Impresora DICOM o 
Windows 

Profesionales clínicos o de TI del 
centro. 

 
Ciberseguridad 
La seguridad de los dispositivos es una responsabilidad compartida entre Hologic y los 
centros médicos. Si no se mantiene la ciberseguridad, se podrá poner en peligro la 
funcionalidad del dispositivo, la disponibilidad o la integridad por la pérdida de los datos 
(médicos o personales), o la exposición a amenazas de seguridad de otros dispositivos o 
redes conectados. Para asegurar la ciberseguridad de sus unidades y conservar su 
funcionalidad y seguridad, Hologic mantiene una serie de controles de ciberseguridad. 

Todas nuestras unidades utilizan el sistema operativo estándar de Windows. Durante la 
instalación, recomendamos que el centro implante todas las medidas de seguridad que sean 
necesarias y estén definidas por sus propios requisitos internos, como lo haría con cualquier 
otro PC conectado a la red. 

El centro podrá configurar el sistema operativo Windows con todos los protocolos de red y 
permisos necesarios. Por ejemplo, podrá añadir: 

 •  ID y contraseñas de usuarios, 
• autorización por niveles con la autenticación correspondiente, 

 •  restricciones a la instalación del software, 
 •  requisitos de contenido de confianza, incluida la verificación del código de la firma, 
 •  configuración de las actualizaciones de Windows, incluidas las versiones de seguridad. 

Además, nuestro software de imágenes (Vision) se puede proteger mediante contraseña 
para que determinados usuarios puedan acceder al sistema operativo sin tener que abrir el 
software Vision. 

La unidad viene con una llave física que enciende el sistema de rayos X. Esto permite que 
el sistema se bloquee, por lo que incluso si se accede al software no se pueden iniciar los 
rayos X. 
 
Esta unidad está diseñada para utilizarse como unidad independiente o conectarse al SACI 
interno del centro o a otra red de circuito cerrado. No está previsto que se conecte a Internet, 
a menos que: (a) el centro reciba de Hologic instrucciones específicas para hacerlo, o (b) el 
centro tome las precauciones adecuadas que garanticen la ciberseguridad de la unidad 
frente a las amenazas relacionadas con la conexión a Internet.  

Para seguir garantizando la seguridad del producto según sea necesario durante todo el 
ciclo de vida de la unidad, Hologic desarrollará actualizaciones o parches para el software 
Vision. 

 2.1.0 Cont. 
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Se podrán implementar medidas de seguridad adicionales, incluido el cifrado, y Hologic 
podrá trabajar con el departamento de TI de los centros para reducir el riesgo de los 
pacientes como resultado de una violación de la ciberseguridad. 

 

Limpieza 
Compartimento interno 
Las muestras que contienen especímenes biológicos pueden albergar agentes infecciosos 
que son peligrosos para la salud. Siga los correspondientes procedimientos de 
bioseguridad; cuando manipule especímenes de tejido o cualquier material con el que entren 
en contacto, utilice guantes. 

Limpie periódicamente el interior del armario con alcohol isopropílico al 70-90 % o hipoclorito 
de sodio diluido (la lejía doméstica al 5,25 %-6,15 % diluida en la proporción 1:500 ofrece la 
concentración adecuada). Asegúrese de que el área de especímenes, marcada en la base 
de la cámara, esté bien limpia. 

Compartimento externo 
Limpie periódicamente las superficies exteriores con alcohol isopropílico, hipoclorito de 
sodio, o agua con jabón suave (consulte más arriba las concentraciones correspondientes). 
No empape ni inunde las superficies, ni utilice abrasivos que puedan rayarlas. No permita 
que la humedad entre en contacto con ninguno de los componentes eléctricos del sistema. 
Para verificar que no deterioran el acabado, pruebe los productos de limpieza en un área 
pequeña y poco visible de las cubiertas metálicas y de plástico. 

2.1.0 Cont. 
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Inspección de las cajas 
El sistema Faxitron Path se presenta en dos cajas, una de ellas una caja de madera de 
grandes dimensiones. Solicite al transportista las lleve a un área donde puedan mantenerse 
a salvo de robos, daños o condiciones ambientales extremas hasta que el representante 
autorizado de Hologic pueda instalar el sistema. 

Compruebe que no estén dañadas. Si cualquiera de ellas parece estar dañada, póngase en 
contacto con Hologic llamando al +1 -800-447-1856.   
La caja de madera mide alrededor de 1,2 m (4 pies) de alto. Contiene la unidad de 
especímenes, un ordenador y los manuales del sistema. La otra caja contiene el monitor del 
sistema. 

 

Elevación y transporte de las cajas de madera 
Precaución: la caja pesa aproximadamente 250 kg (550 libras). El sistema embalado debe 
mantenerse en posición vertical, como aparece indicado en la caja del envío.  

 
Desempaquetado y montaje del sistema 
El sistema Faxitron Path debe desembalarse y configurarse por un representante autorizado 
de Hologic, Inc. 

 

Ubicación 
La ventilación y el conector de alimentación del sistema Faxitron Path se encuentran en la 
parte posterior del armario. Para permitir que el aire circule adecuadamente y que el usuario 
pueda desconectar el cable de alimentación, cuando instale la unidad deje al menos 15 cm 
(6 pulgadas) de espacio libre detrás de la misma. 

 
 
 

 2.2.0 
Configuración 
del sistema Path 
de Faxitron 
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Condiciones ambientales 
Operativas: 
Temperatura:    entre 15,5 y 30 grados C (entre 60 y 86 grados F).   
Humedad relativa:    < 75 %.   
 
Almacenamiento y transporte: 
Temperatura:   entre 0 y 45 grados C (entre 32 y 113 grados F).   
Humedad relativa:   < 75 %.   
 
 
Este equipo está diseñado para funcionar en las siguientes condiciones: 

• Uso en interiores 
• Altitud hasta 2000 metros (6562 pies) 
• Contaminación de grado 2 
• Categoría de sobretensión II 
 

Una vez instalado, el Faxitron Path no debe moverse. El sistema fue diseñado como un 
sistema estacionario para ser instalado en un mostrador o mesa. 

 
PROTECCIÓN RADIOLÓGICA 
• Armario con protección frente a radiación. 
• Puerta del compartimento equipada con enclavamientos de seguridad dobles. 
• Radiación: por debajo de 1 µSv/h (0,1 mR/h) a 5 cm (2 pulgadas) de la superficie exterior 

al máximo voltaje. 
• Garantía de cumplimiento de las normas establecidas por el Centro de Aparatos y Salud 

Radiológica de la Administración de Alimentos y Medicamentos de los Estados Unidos, 
(21 CFR 1020.40). 

• Diseñado conforme a las normas fijadas por Underwriters Laboratories (EE. UU. y 
Canadá). 

• Hologic recomienda que los usuarios reciban formación básica en seguridad frente a la 
radiación ionizante antes de utilizar el sistema. 

 
 
CONTROL DE LA EXPOSICIÓN: automático o manual. 

CICLO DE TRABAJO DE LOS RAYOS X: 50 % 

INFORMACIÓN DEL LÁSER:   producto láser de clase 1 

IEC 60825-1 Ed. 2 

De acuerdo con las normas 21 CFR 1040.10 y 1040.11,  
a excepción de las desviaciones contempladas en el aviso 
sobre láser n.º 50 del 24 de junio de 2007. 

REQUISITOS DE POTENCIA:  máximo de 100-250 VCA, 50/60 Hz, 200 VA 

POTENCIA CALORÍFICA:        máximo de 527,5 kJ/h (500 BTU/h) 

 
 
 

 2.3.0 
Especificaciones 
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DIMENSIONES EXTERNAS (aproximadas) 
 
 cm pulgadas 
Altura 90 36 
Anchura 59 23 
Profundidad 54 21 

 
 
DIMENSIONES INTERNAS DEL COMPARTIMENTO (aproximadas) 
 

 cm pulgadas 
Altura 57 22,3 
Anchura 39 15,5 
Profundidad 42 16,5 

 
 
PESO (aproximado) 
 

 Con Ordenador, monitor, teclado y accesorios 
 kg lb 
Neto 210 465 
Del paquete 258 570 
 Solo el armario 
Neto 188 415 
Del paquete 236 520 

 
 

 

 2.3.0 Cont. 

 
 
 
 
 

59 cm 54 cm 

90
 c

m
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SECCIÓN 3 
Calibración de la cámara 
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Calibración 

En el momento de la puesta en marcha inicial del sistema, o en cualquier momento deseado 
por el usuario, se podrá realizar la calibración del sistema. Tras la puesta en marcha inicial y 
transcurrido un periodo de doce (12) horas, deben realizarse las siguientes calibraciones. 
Para optimizar la calidad de las imágenes, el software Vision y el hardware requieren la 
realización periódica de la calibración. Esta calibración requiere la obtención de imágenes de 
referencia. Dichas imágenes se pueden agrupar en tres (3) categorías: imágenes 
desplazadas, imágenes oscuras e imágenes de campo plano. 
El software Vision se abrirá directamente en Home Menu (Menú de inicio; Figura 3.1.1) 
o en la página Calibration (Calibración; Figura 3.1.2) dependiendo del tiempo 
transcurrido desde la última calibración del sistema. Para iniciar manualmente una 
calibración, diríjase a la página Calibration (Calibración).  

Precaución: antes de iniciar la calibración, verifique que el compartimento esté vacío. 

Para iniciar manualmente una calibración, haga clic en el botón «Calibrate» (Calibrar) de 
Home Menu (Menú de inicio). 

 
 
 
 
 
 
 
 
 
 
 
 

A continuación, se pedirá la confirmación del usuario mediante la selección de «Start 
Calibration» (Iniciar calibración). 
 
 
 
 

 
 

 
 
 
 
 

Cuando pulse, se llevará a cabo el proceso de calibración y se mostrará un cuadro de mensaje 
de la misma. Durante la calibración, el cuadro de mensaje alternará entre «SYSTEM IN 
CALIBRATION» (SISTEMA EN CALIBRACIÓN) y «X-RAY ON» (RAYOS X ENCENDIDOS). 
Véase la Figura 3.1.3.  
 
 
 
 
 
 
 
 
 
El software volverá de forma automática al Home Menu (Menú de inicio) cuando se complete 
la calibración. 
 
Para obtener más información sobre la calibración, consulte las secciones 5.2.0 y 5.2.1. 

 3.1.0 
Calibración  
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 3.1.1  
Botón Calibrate para calibrar el 
sistema  
 
 
 
 
 
 
 
 
 
 
Figura 3.1.2 
Mensaje Start Calibration 
para iniciar la calibración 
 
 
 
 
 
 
 
 
 
 
 
Figura 3.1.3  
Progreso de la calibración 
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SECCIÓN 4 
Inicio rápido: 

funcionamiento básico de 
Faxitron Path 
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Antes de encender el sistema, asegúrese de que todos los cables estén bien enchufados en 
el sistema, el ordenador y el monitor. 

Consulte la Sección 2 de este manual, Instalación y configuración, y las guías de 
configuración rápida y de inicio rápido suministradas con el sistema Path. 

 

 

 

 

 

 

 

 

 

 

 

 

Protocolo de la secuencia de puesta en 
marcha del sistema 

Para garantizar que el funcionamiento del sistema y la calidad de las imágenes sean los 
adecuados, deberá seguirse esta secuencia de puesta en marcha: 

Sistema de encendido 
• Coloque el interruptor de alimentación de la parte posterior del armario Path en la 

posición «ON». 
• Gire la llave de contacto de la parte frontal del armario Path hasta «ON» (en el 

sentido de las agujas del reloj a la posición de las tres). 
• Encienda el ordenador y el monitor. 

Inicio del software 
• Compruebe que no haya nada en el compartimento de rayos X del 

Path. 
• El software Vision debería iniciarse automáticamente cuando el 

sistema operativo Windows haya terminado de arrancar. Si el 
software no se inicia automáticamente, haga doble clic en el icono 
de Vision que se encuentra en el escritorio de Windows. 

Calibrar 
• En el momento de la puesta en marcha inicial del día el software debería abrirse en 

la página Calibration (Calibración). 
• Presione el botón «Calibrate» (Calibrar) y permita que el sistema complete la calibración. 

Recomendaciones extra para obtener una calidad de imagen óptima. 

Cada día, antes de comenzar a utilizar el sistema, permita que se realice una calibración 
completa en el mismo. El sistema está configurado para realizar dicha calibración en el 
momento en que inicie el software Vision. 

Después de trasladarlo a otra habitación, lleve a cabo una calibración completa del sistema 
para evitar posibles problemas en la obtención de imágenes relacionados con las diferencias 
de temperatura y humedad ambiente entre las habitaciones. 

 4.1.0 
Inicio rápido 
 
 
 
Figura 4.1.1 
Panel frontal de Faxitron Path 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 4.1.2 
Icono de escritorio de Vision 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 

Tecla de 
encendido/
apagado 
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Procedimientos básicos de obtención de imágenes 

Advertencia: el uso de Path de una manera diferente a la descrita en este manual podría 
provocar un mal funcionamiento del equipo o lesiones personales. 

Advertencia: para evitar el contacto con muestras de tejido de pacientes que sean 
potencialmente peligrosas, utilice recipientes o guantes autorizados. 

Start Procedure (Iniciar procedimiento) 

• En la página Home Menu (Menú de inicio), seleccione el botón Start Procedure 
(Iniciar procedimiento). 

 

 

 

 

 

 

 

 

 

• Al usuario se le darán las opciones Select from Work List (Seleccionar en la lista 
de trabajo), Manual Entry (Introducción manual), Select from Database 
(Seleccionar en la base de datos) o Continue with current patient (Continuar con 
el paciente actual). 

• Para introducir manualmente un nuevo procedimiento, seleccione el botón Manual 
Entry (Introducción manual). 

 

 

 

 

 

 

 

• Se abrirá el cuadro de diálogo «Patient Information Editor» (Editor de la información 
sobre el paciente). 

 

 4.2.0 
Obtención de 
imágenes 

 
 
 
Figura 4.1.3 
Home Menu (Menú de inicio) 
del programa Vision (pantalla 
principal) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 4.1.4 
Opciones de Start Procedure 
(Iniciar procedimiento) 
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Nota: Los campos obligatorios aparecen indicados con un 
asterisco blanco (*). 
Los campos obligatorios y predeterminados son: Patient Name 
(Nombre del paciente), Patient ID (ID del paciente), Accession 
Number (Número de ingreso) y Laterality (Lateralidad). 

• Introduzca todos los campos obligatorios. Si falta algún campo obligatorio, el botón 
Accept (Aceptar) no estará activo. El usuario podrá completar otros campos si lo desea. 

Nota: La fecha de nacimiento deberá introducirse como aaaa/mm/dd (por ejemplo, 1962/08/13).  

• Para activar la obtención de imágenes, seleccione Accept (Aceptar). 

Obtención de imágenes de rayos X 

• Coloque los especímenes en un recipiente para especímenes proporcionado por Hologic, 
Inc. o su institución, y póngalo dentro del compartimento de rayos X Path. El área de 
obtención de imágenes está marcada con una banda adhesiva del contorno. (El usuario 
también puede colocar el espécimen y el recipiente en la bandeja de aumento suministrada 
con el sistema Path). 

• Pulse el botón verde Start X-ray (Comenzar radiografía) del software o de la parte frontal 
del armario de rayos X para iniciar la obtención de imágenes o radiografías. 

• Espere a que se visualice la imagen. 
Nota: Si el modo Full Auto (Totalmente automático) está seleccionado, se realizarán dos 
radiografías; la primera, para determinar los mejores ajustes, y la segunda para obtener la 
imagen. Los ajustes utilizados durante la exposición (kV y tiempo) se mostrarán en la 
pantalla LCD de los armarios. 

 4.2.0 Cont. 
 
Figura 4.1.5 
Pantalla Patient Data (Datos 
del paciente) 
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 El software Vision está configurado para guardar automáticamente la imagen en la base de 
datos de Faxitron, en la unidad local del ordenador del sistema. El usuario también puede 
guardar la imagen en el servidor de instalaciones haciendo clic en el icono PACS (SACI). 
Véase la Figura 4.1.6. 

4.2.0 Cont. 
 

 

 

Para obtener más información sobre cómo ajustar la configuración de las imágenes, los 
controles de rayos X y las opciones de revisión y guardado, consulte la Sección 5. 

  
Figura 4.1.6 
Pantalla de la imagen 
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SECCIÓN 5 

Funcionamiento del 
software VISION 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

 
 
 
 



 
  

MANUAL DE USUARIO DE FAXITRON PATH | HOLOGIC | REVISIÓN 025   
 

SECCIÓN 
Software 
VISION 5 

5-2 

Faxitron® Path 
Sistema de radiografía de muestras 

El software Vision es un completo paquete de obtención y procesamiento de imágenes que 
está diseñado exclusivamente para trabajar con los generadores de rayos X de Faxitron (como 
los sistemas VersaVision, Faxitron Path, CoreVision y BioVision). Además de las funciones de 
obtención y procesamiento, el software ofrece un amplio módulo de base de datos que permite 
el control y el mantenimiento de archivos y el almacenamiento, la tramitación y la recuperación 
de las imágenes por parte del usuario. El software también es compatible con Imagenología 
Digital y Comunicaciones en Medicina (DICOM), lo que permite guardar e imprimir imágenes 
de los pacientes en formato DICOM 3.0. El software ha sido preinstalado en el ordenador que 
se incluye con el sistema de rayos X. 

Para obtener la mejor calidad de las imágenes, será necesario calibrar el sistema cada nuevo 
día de uso. Para garantizar que la calidad de las imágenes sea óptima, el usuario del sistema 
también podrá realizar la calibración en cualquier momento. 

Después de la calibración, se mostrará Menú de inicio, que permite navegar al resto de áreas 
del software. Para facilitar el uso, se proporcionan botones de aplicación. Véase la Figura 5.0.1. 
Estos botones están en el centro de la pantalla. Las descripciones y definiciones de los botones 
aparecen explicadas en las próximas secciones de este manual.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Protocolo de la secuencia 
Para garantizar que la funcionalidad del sistema y la calidad de las imágenes sean las 
adecuadas, deberá seguirse esta secuencia de puesta en marcha: 

Encienda el armario Faxitron Path mediante el interruptor situado en su parte posterior. 
(El interruptor de alimentación está junto a la toma de corriente del cable de alimentación). 
Pulse «l» para «ENCENDERLO» y «0» para «APAGARLO». 

Encienda el armario Faxitron Path introduciendo la llave Faxitron Path en el interruptor de 
cerradura con llave, situado en el panel frontal, y girándola en el sentido de las agujas del reloj 
hasta la posición de las tres. Nota: La llave no se puede extraer en esta posición. 

Encienda el ordenador y el monitor.  

El software Vision se iniciará automáticamente cuando Windows haya 
completado su secuencia de arranque. Aparecerá brevemente un cuadro de 
diálogo para indicar que el software se ha inicializado y está cargado. Nota: 
Si Vision no se inicia automáticamente, haga doble clic con el botón 
izquierdo del ratón en el icono del software Vision (ubicado en el escritorio 
de Windows). Véase la Figura 5.1.1. 

El software Vision se abrirá en Home Menu (Menú de inicio) o en la página Calibration 
(Calibración), dependiendo del tiempo transcurrido desde la última calibración del sistema. 

Para obtener información sobre los protocolos de calibración, consulte «Calibración de la cámara» 
en la Sección 3 y «Descripción general de la calibración de la cámara», en la Sección 5.2.1. 

 5.0.0 
Descripción 
general del 
software Vision 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.0.1  
Home Menu (Menú de inicio) del 
software Vision (pantalla de inicio) 
 
 
 
 
 
 
 
 

5.1.0 
Puesta en marcha 
del software 
 
 
 
 
 
 
 
 
 
Figura 5.1.1 
Icono de escritorio del software 
Vision 
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Introducción a la calibración 
 
Para optimizar la calidad de las imágenes, el software Vision y el hardware requieren la 
realización periódica de la calibración. Esta calibración requiere la obtención de imágenes de 
referencia.  

En el momento de la puesta en marcha inicial del sistema, o en cualquier momento deseado 
por el usuario, se podrá solicitar y realizar la calibración del sistema. Se recomienda que, 
transcurrido un periodo de doce (12) horas, se realicen las siguientes calibraciones. 

Estas imágenes de calibración de referencia se utilizan para calibrar, píxel por píxel, una 
imagen de rayos X «sin procesar» con el fin de generar una imagen «corregida», que será 
visualizada. Las correcciones realizadas a la imagen abarcan correcciones de ganancia, 
contraste y linealidad. 

 

Secuencia de la calibración 
 
Para mayor comodidad, el software Vision combina los numerosos pasos de calibración en un 
solo paso unificado. 

Cuando un sistema Faxitron de rayos X ha estado apagado durante más de doce (12) horas, 
el sistema solicitará automáticamente que se vuelva a calibrar. Se recomienda 
encarecidamente que el sistema se vuelva a calibrar tras períodos prolongados de inactividad 
o después de que el sistema se traslade de una estancia a otra que tenga unos parámetros de 
temperatura o humedad ambiente potencialmente diferentes.  

Para calibrar el sistema en cualquier momento, haga clic en el botón 
Calibrate (Calibrar) en Home Menu (Start-up Screen) (Menú de inicio 
[Pantalla de puesta en marcha]) de Vision y, a continuación, presione 
Start Calibration (Iniciar calibración). Véanse las Figuras 5.2.1 y 5.2.2. 
Durante la calibración, el diálogo mostrará un mensaje de estado. 
Véase la Figura 5.2.3. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Durante la calibración, puede que se generen rayos X. Durante la generación de rayos X, se 
hará visible el botón Stop X-Ray (Detener rayos X) para permitir que el usuario tenga la opción 
de detener los rayos X utilizando el software. 

 5.2.0 
Descripción 
general de la 
calibración de la 
cámara 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.2.1  
Botón Calibrar del menú de inicio  
 
 
 
 
 
 
 
 
Figura 5.2.2 

Botón Start Calibration para 
iniciar la calibración 
 
 
 
 
 
 
 
 
Figura 5.2.3 
Estado de la calibración 
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Periódicamente, convendría incorporar las características de atenuación de los rayos X de un 
atenuador uniforme en las imágenes de calibración de referencia de campo plano. Por ejemplo, 
si todos los objetos radiografiados se colocan sobre una placa plástica delgada, las 
características de atenuación de los rayos X de la placa se observarán en cada imagen 
obtenida. En este caso, la colocación de la placa dentro del haz de rayos X durante la obtención 
de la imagen de calibración de referencia de campo plano podría mejorar la calidad de las 
imágenes. A continuación se presenta un resumen del protocolo de calibración avanzada para 
«ambos» (el campo plano y la imagen): 
Coloque el atenuador uniforme sobre el sensor. Toda la superficie del sensor deberá estar 
cubierta por el atenuador. Para obtener resultados ideales, el atenuador deberá ser mayor que 
el área de obtención de imágenes del sensor. 
Para enfocar el menú, desde la pantalla de puesta en marcha del software de obtención de imágenes, 
presione el icono ^ situado en la parte superior derecha. En el menú horizontal situado en la parte 
superior de la pantalla, seleccione el elemento «Tools» (Herramientas) del menú desplegable y, a 
continuación, vaya hasta «Advanced Tools» (Herramientas avanzadas) y, después, a «X-Ray 
Calibration/Exposure Setup» (Calibración de rayos X/Configuración de la exposición). 

Nota: Los valores de kV, el tiempo de exposición y las unidades analógico-
digitales (UAD) podrían ser diferentes de los mostrados. 

• En «X-Ray Generator and Exposure Settings» (Ajustes del generador de rayos X y la 
exposición), introduzca el ajuste de kV del generador en el campo correspondiente. 

• Ajuste la «Magnification» (Ampliación) o deje el uno (1.0) como ajuste predeterminado. 
• En el cuadro de diálogo, seleccione el botón «Set for» (Ajustar para) «Both» (Ambos). 
• En «user ADU target» (blanco de las UAD del usuario), deje el ajuste predeterminado. La 

exposición a los rayos X se interrumpirá cuando el sensor haya acumulado un nivel medio de 
señal de UAD que sea aceptable para el generador de rayos X que usted tiene. 

• Deje el tiempo de exposición predeterminado de la prueba y haga clic en el botón Acquire 
(Obtener). El sistema dará inicio automáticamente a los rayos X y obtendrá una imagen. 

• Cuando la exposición a los rayos X haya finalizado, haga clic en el botón Estimate/Calculate 
(Estimar/Calcular). 

• Registre la lectura del tiempo de exposición «Time[s]» (Tiempo[s]) calculado. El sistema 
calculará este tiempo y el número aparecerá en gris. 

 5.2.1 
Calibración 
avanzada 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.2.4 
Generador de rayos X y cuadro 
de diálogo de la exposición 
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• Introduzca la lectura del tiempo de exposición «Time[s]» (Tiempo[s]) calculado en la casilla 
de tiempo «Test Exposure» (Exposición de prueba). Para dar inicio automáticamente a los 
rayos X y obtener una imagen, presione el botón Acquire (Obtener). 

• Cuando la exposición a los rayos X haya finalizado, haga clic en el botón Estimate/Calculate 
(Estimar/Calcular). 

• Registre la lectura del tiempo de exposición «Time[s]» (Tiempo[s]) calculado. 

• Vuelva a introducir la lectura del tiempo de exposición calculado en la casilla de tiempo «Test 
Exposure» (Exposición de prueba). 

• Haga clic en el botón Accept Settings (Aceptar configuración).  

• Realice un procedimiento estándar de calibración, tal y como se describe en la sección 
«Descripción general de la calibración de la cámara».  

Como se describió anteriormente, puede que los usuarios experimentados quieran ajustar «X-
Ray Cal (Flat-Field)» (Calibración de rayos X [Campo plano]) y «Manual Image» «Exposure 
Settings» (Imagen manual) (Ajustes de la exposición) por separado o «Both» (Ambos) (el 
campo plano y la imagen manual). Seleccionando el botón de opción «Flat Field» (Campo 
plano), el sistema determinará el tiempo de exposición óptimo para obtener imágenes de 
campo plano al nivel de UAD deseado. Por consiguiente, la selección de «Manual Image» 
(Imagen manual) determinará el tiempo de exposición óptimo para el sistema con un objeto 
que atenúe la señal de rayos X. Para obtener los mejores resultados, el objeto deberá cubrir 
toda el área de obtención de imágenes del sensor. 

Después de seleccionar «X-Ray Cal (Flat-Field)» (Calibración de rayos X [Campo plano]) y 
«Manual Image» (Imagen manual) y de haber ajustado el nivel de UAD, seleccione el botón 
Acquire (Obtener). Para seleccionar «Manual Image» (Imagen manual), conviene tener el 
objeto o el atenuador de rayos X en el haz de rayos X. Para generar rayos X y obtener una 
imagen, pulse el botón Acquire (Obtener). Cuando la exposición a los rayos X haya finalizado, 
haga clic en el botón Estimate/Calculate (Estimar/Calcular). El sistema calculará el tiempo 
óptimo, y el número aparecerá en gris. Para guardar los «Exposure Settings» (Ajustes de 
exposición) en el archivo de configuración del sistema, haga clic en el botón Accept Setting 
(Aceptar ajuste). Nota: Solamente se guardarán los ajustes del botón de opción que haya 
seleccionado. A continuación, realice un procedimiento estándar de calibración, tal y como se 
describe en la sección «Descripción general de la calibración de la cámara». 

 

 5.2.1 Cont. 

 

El botón Start Procedure (Iniciar procedimiento; véase la Figura 5.0.1) lleva al usuario a la 
página Patient Data Entry (Introducción de datos del paciente), que proporciona métodos para 
introducir los datos de los pacientes. Si no se ha configurado una lista de trabajo, la opción 
aparecerá en gris y solamente se podrá acceder a las opciones Continue with Current Patient 
(Continuar con el paciente actual), Manual Entry (Introducción manual) y Select from 
Database (Seleccionar en la base de datos). Las opciones aparecen explicadas en las 
siguientes secciones. 
 

 
 

 5.3.0 
Datos del paciente 
 
 
 
 
 
Figura 5.3.1 
Pantalla Introducción de datos del 
paciente 
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SELECCIONAR EN LA LISTA DE TRABAJO  

(Lista de trabajo de modalidad remota) 
Si se ha configurado una lista de trabajo, el usuario podrá hacer clic en el botón Select from 
Work List (Seleccionar en la lista de trabajo), que mostrará la siguiente página. Véase la  
Figura 5.3.2 a continuación. 

  

 

A la izquierda hay varios filtros que pueden utilizarse para buscar procedimientos programados 
para la aplicación de la terminal (AE). Verifique que esté definido el título AE de la terminal; a 
continuación, cualquier campo individual o cualquier combinación de campos podrá utilizarse 
como filtro para buscar procedimientos programados para este AE. Seleccionando el botón 
Query (Consulta) situado en la esquina inferior izquierda, la tabla se rellenará con las entradas 
que coincidan con la información consultada. 

El usuario podrá entonces hacer clic en cualquier entrada y pulsar Submit (Enviar) para rellenar 
automáticamente el editor de la información sobre la obtención de imágenes con la información 
del paciente. 

AVISO: El usuario también podrá hacer doble clic en cualquier entrada de la tabla para acceder 
rápidamente al editor de la información sobre la obtención de imágenes sin tener que presionar 
Submit (Enviar). 

Se abrirá el editor de la información sobre la obtención de imágenes Patient Information Dialog 
(Diálogo de información sobre el paciente). Véase la Figura 5.3.3. Para proceder a la obtención 
de imágenes, rellene el resto de los campos obligatorios y haga clic en Accept (Aceptar).  

 

 5.3.1 
Seleccionar en la 
lista de trabajo 
 
 
 
 
 
Figura 5.3.2 
Diálogo de búsqueda en la lista 
de trabajo de la modalidad 
 
 

 
 
 
 
 
 
 
 
 
 

Nota: Todos los datos de los 
pacientes son ficticios.  
Cualquier parecido con personas 
reales es pura coincidencia. 
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Nota: Los campos obligatorios aparecen indicados con un asterisco blanco (*). Los campos 
obligatorios y predeterminados son: Patient Name (Nombre del paciente), Patient ID (ID del 
paciente), Accession Number (Número de 
ingreso) y Laterality (Lateralidad). 
 
Antes de poder seleccionar el botón Accept 
(Aceptar), el usuario deberá introducir todos los 
campos obligatorios. Si así lo desea, el usuario 
también podrá introducir los campos Date 
(Fecha), Referring Physician (Médico remitente), 
Procedure Name (Nombre del procedimiento), 
Sex (Sexo), Technician (Técnico), Position View 
(Vista de la posición), Body Part (Parte 
anatómica) y Study ID (Identificación del 
estudio). El nombre del procedimiento, la vista de 
la posición y la parte anatómica se eligen 
mediante un menú desplegable. 
 
Nota: La fecha deberá indicarse como 

aaaa/mm/dd (por ejemplo, 1962/08/13). 
Si no se introduce la fecha válida, se 
podrán producir errores al intentar 
recuperar las imágenes. 

 
Nota: En función de la aplicación, «los campos 

obligatorios» pueden ser modificados o 
eliminados. Póngase en contacto con el 
servicio de asistencia técnica de Hologic 
para obtener más información. 

 
Para regresar a la página de introducción de 
datos de los pacientes, seleccione Accept 
(Aceptar) para continuar o Start a New Patient 
or Procedure (Iniciar un paciente o 
procedimiento nuevo). 

 5.3.1 Cont. 
 
 
Figura 5.3.3 
Editor de la información sobre la 
obtención de imágenes 
 
 
 
 

 
 
 

Continuar con el paciente actual 
 
 
Haga clic en el botón Continue with Current Patient para continuar con el procedimiento del 
paciente actual. Se abrirá «Image Information Editor» (Editor de la información de las 
imágenes). Véase la Figura 5.3.3. Siga el procedimiento y las notas anteriores. 
 

 5.3.2 
Continuar con el 
paciente actual 

 
 
 

Introducción manual 
 
 
Haga clic en el botón Manual Entry para introducir manualmente un nuevo procedimiento. Se 
abrirá el editor de la información sobre la obtención de imágenes. Véase la Figura 5.3.3. Siga 
el procedimiento y las notas anteriores. 
 

 5.3.3 
Introducción 
manual 
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Seleccionar en la base de datos 
 
Si selecciona el botón Select from Database (Seleccionar en la base de datos), aparecerá la 
siguiente página. Véase la Figura 5.3.4 a continuación. 

 
 
El usuario selecciona a un paciente en la tabla situada en el lado derecho de la página y,  
a continuación, hace clic en el botón Accept (Aceptar), que abre el editor de la información 
sobre las imágenes. (Nota: Para abrir el editor de información sobre las imágenes, el usuario 
también puede hacer doble clic en la entrada de la tabla). A continuación, siga el 
procedimiento y las notas de la página 5.7. 
 
Nota: Para ver la información oculta de los pacientes, utilice la barra de desplazamiento 
situada en la parte inferior de la pantalla. 
 
Vision permite al usuario reducir la lista de pacientes introduciendo información específica en 
la ventana «Search Parameters» (Parámetros de búsqueda) situada en el lado izquierdo de 
la página. Solamente se mostrarán aquellos pacientes que coincidan con todos los 
parámetros de búsqueda.  
 

 5.3.4 
Seleccionar en la 
base de datos 
 
 
Figura 5.3.4 
Selección de pacientes en las 
entradas de la base de datos 
local 
 
 

 
 
 

Nota: Todos los datos de los 
pacientes son ficticios.  
Cualquier parecido con personas 
reales es pura coincidencia. 



 
  

MANUAL DE USUARIO DE FAXITRON PATH | HOLOGIC | REVISIÓN 025   
 

SECCIÓN 
Software 
VISION 5 

5-9 

Faxitron® Path 
Sistema de radiografía de muestras 

Si el usuario desea cambiar o ver la información después de haberla introducido 
pero antes de haber tomado una imagen, podrá pulsar en el icono Patient Data 
(Datos del paciente) situado en la esquina superior izquierda. Véase la  
Figura 5.3.5. 

 

Se abrirá la ventana de edición de la información sobre el paciente o sobre la obtención de 
imágenes. Esta ventana de edición se rellenará con toda la información que se haya introducido 
o seleccionado previamente. Véase la Figura 5.3.6. Nota: La ventana de edición incluirá ahora 
el botón Cancel (Cancelar). 

El usuario podrá cambiar o añadir la 
información que desee y luego hacer clic en: 

• el botón Accept (Aceptar) para guardar los 
cambios y continuar con la obtención de 
imágenes; 

• el botón Cancel (Cancelar) para cancelar los 
cambios y continuar con la obtención de 
imágenes. El software volverá a la 
información original sobre el paciente que se 
haya introducido, o 

• el botón Start a New Patient or Procedure 
(Iniciar un paciente o procedimiento nuevo), 
que devolverá al usuario a la pantalla de 
introducción de datos del paciente. Véase la 
Figura 5.3.1. 

  

 

 
 
 

 

 

 

 

 

 

 

 

 

Una vez que el usuario haga clic en el botón Accept (Aceptar), el sistema estará listo para 
obtener imágenes o radiografías. 

Las radiografías se inician presionando el botón verde Start (Comenzar) en la parte frontal del 
armario Faxitron Path o haciendo clic en el botón Start X-Ray (Comenzar radiografía) situado 
en la esquina inferior derecha de la pantalla. Véase la Sección 4.2.0, Obtención de imágenes. 
El sistema tomará una breve radiografía «de muestra», o una toma previa (que se explica en 
la Sección 5.4.4), seguida de una exposición más prolongada para obtener la imagen. El 
software procesará la imagen antes de que se muestre en la pantalla del monitor. Una vez se 
muestre la imagen, se activarán los botones situados en los lados izquierdo y derecho de la 
pantalla, tratados en toda esta sección. 

 5.3.5 
Icono de datos del 
paciente 
 
Figura 5.3.5 
Datos del paciente 
 
 
 

Figura 5.3.6 
Diálogo de Datos del paciente 
 
 
 
 
 



 
  

MANUAL DE USUARIO DE FAXITRON PATH | HOLOGIC | REVISIÓN 025   
 

SECCIÓN 
Software 
VISION 5 

5-10 

Faxitron® Path 
Sistema de radiografía de muestras 

 
 
 
 
 
Después de obtener una imagen, el usuario podrá 
ver, pero no editar, la información del paciente 
haciendo clic en el icono Patient Data (Datos del 
paciente) que se muestra en la Figura 5.3.5. Esto 
mostrará un cuadro de diálogo modificado Patient 
Information (Información sobre el paciente), como se 
muestra en la Figura 5.3.7. Dicho cuadro incluye dos 
botones: Close Dialog (Cerrar diálogo) o Start a 
New Patient or Procedure (Iniciar un nuevo 
paciente o procedimiento).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Una vez tomada la imagen, se podrán ver las propiedades de la imagen actual 
pulsando el icono (i) situado en la esquina superior derecha. Véase la Figura 5.3.8. 
Aparecerá el cuadro de diálogo Image Properties (Propiedades de la imagen) en la 
esquina superior derecha de la imagen. El cuadro es semitransparente para 
permitirle a uno ver lo que hay por debajo del cuadro. Véase la Figura 5.3.9. 
 

 5.3.5 Cont. 
 
 
Figura 5.3.7 
Diálogo de información sobre el 
paciente tras obtener las 
imágenes 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.3.8 
Icono de propiedades de la 
imagen 
 
 
 
Figura 5.3.9 
Diálogo de propiedades de la 
imagen (solo lectura) 
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El software Vision proporciona varias herramientas y menús para controlar varios atributos o 
parámetros de las imágenes, la obtención de rayos X, las vistas de imagen, las herramientas 
de imagen y los ajustes o accesos de DICOM. Las herramientas más utilizadas están situadas 
en una barra de herramientas. La barra de herramientas y los menús se describen con más 
detalle en las próximas páginas. 

 
Con un solo clic, el software Vision permite acceder a una serie de herramientas o funciones de 
uso común con una barra de herramientas vertical ubicada en el lado izquierdo de la pantalla. En 
las páginas siguientes se ofrecen descripciones más detalladas. Véase la Figura 5.4.1. 

 
 
Ver o modificar la información sobre  
el paciente 
(Véase la Sección 6.3.5 y Figura 6.3.5) 
 
Icono de mejora de la imagen 
 
 
 
Herramienta Nivel de la ventana  
y contraste 
 
 
Herramienta Zoom digital 
 
 
 
Herramientas de anotación 
 
 
 

PACS Save (Guardar en SACI) 
 
 
 

PACS Print (Impresión en SACI) 

 

Control de la exposición (Panel de control del dispositivo) 

 

 
Volver al menú principal 

 

 
Apagado del sistema 

 

 5.4.0 
Barra de 
herramientas  
y menús 
 
 
5.4.1 
Barra de 
herramientas 
lateral 
 
Figura 5.4.1 
Barra de herramientas lateral 
 
 
 

 
 
 
 
 
 

NOTAS: 
 
Las siguientes herramientas están 
siempre activas en la página de 
obtención de imágenes: 
• Ver o modificar la información 

sobre el paciente 
• Control de la exposición 
• Volver al menú principal  
• Apagado del sistema 
 
Las siguientes herramientas se 
desactivarán después de introducir 
los datos del paciente y solamente se 
activarán tras obtener una radiografía: 
• Mejorar la imagen 
• Nivel y contraste de la ventana 
• Zoom digital 
• Anotación 
 
Las herramientas PACS Save 
(Guardar en SACI) y PACS Print 
(Impresión en SACI) solamente se 
activarán después de realizar una 
radiografía y cuando el sistema esté 
conectado a una red SACI. 
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Mejorar imagen 
El botón mostrado en la Figura 5.4.2 procesará la imagen en la pantalla para destacar en ella 
los detalles más pequeños, como las microcalcificaciones y las pequeñas masas. 

 

 

En la obtención de imágenes avanzadas, el algoritmo comúnmente denominado «ecualización 
periférica» o «ecualización del espesor» se aplica a toda la imagen. Además de este algoritmo, 
Hologic emplea un segundo algoritmo desarrollado internamente y llamado «énfasis de las 
calcificaciones». Este algoritmo secundario fue creado para resaltar pequeños detalles de la 
imagen y hacerlos mucho más fáciles de ver y analizar. 

Dado que las imágenes de los pacientes constituyen una categoría más general en cuanto a 
las posibles geometrías y la variedad de espesores, puede que haya geometrías de las 
muestras que representen un reto, y el usuario deberá utilizar esta herramienta con cuidado. 

El sistema estará inactivo (en espera) durante el proceso. Una vez finalizado, el botón 
permanecerá pulsado o activo. El usuario podrá deshacer el proceso pulsando de nuevo el 
botón.  

 5.4.1 Cont. 
 
Figura 5.4.2 
Icono de mejora de la imagen 
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Ajuste de la inversión, el nivel de la ventana y el contraste 
 
El botón, mostrado en la Figura 5.4.3, abrirá la herramienta de ajuste Window Level and 
Contrast (Nivel de la ventana y contraste). Esta herramienta permite al usuario ajustar el nivel 
de la ventana y el contraste de la imagen. El usuario también podrá restaurar el contraste 
original pulsando el botón Original Contrast (Contraste original) o invertir la imagen pulsando 
el botón Invert (Invertir). La inversión cambia el esquema cromático de ser predominantemente 
negro a ser predominantemente blanco, y viceversa. Véase la Figura 5.4.4 siguiente. 
 
 
 
 
 
 
 
 
 
 
 
El usuario también podrá ajustar el contraste 
deseado de la imagen haciendo clic en la barra 
deslizante y moviéndola hacia arriba y hacia abajo o 
haciendo clic en las flechas que correspondan de la 
barra para mover los límites inferior o superior del 
nivel de la ventana. Véase la Figura 5.4.3 
(informalmente, esto también se denomina 
«Equilibrado de la ventana»). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A continuación se muestra el ejemplo de una 

inversión: 
 

 5.4.1 Cont. 
 
 
 
 
 
 
 
Figura 5.4.3 
Icono y controles de la 
herramienta Nivel de la ventana y 
contraste 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.4.4 
Ejemplo de inversión con la 
herramienta Ajuste del contraste 
y Nivel de la ventana 
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Ajuste del zoom dinámico 
 
El icono de la herramienta de zoom, Figura 5.4.5, abrirá la herramienta de ajuste del zoom. 
Después de abrir esta herramienta, el usuario podrá utilizar la barra deslizante para ajustar el 
nivel del zoom o hacer clic en los botones Fit to Specimen (Ajustar al espécimen), Fit to 
Screen (Ajustar a la pantalla) o Zoom 1.0x (resolución completa). Véase la Figura 5.4.6. Para 
navegar por toda la imagen, cuando esta haya sido ampliada, será necesario realizar una 
panorámica. Aparecerá un cuadro de diálogo en miniatura en la esquina superior izquierda de 
la pantalla. Véase la Figura 5.4.7 a continuación. Para mover la imagen en la pantalla principal, 
haga clic y mantenga presionado el botón izquierdo sobre la imagen, y mueva el ratón. 

Tenga en cuenta que, tradicionalmente, esta función también se denomina «Vista panorámica» 
o «Pan and Scan». 

 
 
 
 
 

 
 
 
 
 
 
 
 
Para asegurarse de que el espécimen esté a la vista, el botón 
Fit to Specimen (Ajustar al espécimen) intentará detectar y 
ampliar el espécimen. Si no se detecta un espécimen, este se 
ajustará por defecto al modo anterior (ya sea «Fit to Screen» 
[Ajustar a la pantalla] o «Zoom 1.0x»). 
 
Fit to Screen (Ajustar a la pantalla) ajustará la imagen a la 
pantalla. 
 
Tradicionalmente, Zoom 1.0x se denomina «resolución 
completa», ya que lleva la imagen a una vista 1-1 con la 
resolución del monitor. 
 
 
 
 

 5.4.1 Cont. 
 
 
 
 
 
 
 
 
 
Figura 5.4.5 
Icono de la herramienta Zoom 
 
 
 
Figura 5.4.6 
Herramienta de ajuste del nivel 
de zoom 
 
 
 
Figura 5.4.7 
Ejemplo de vista panorámica 
(izquierda) 
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Anotación 

El botón mostrado en la Figura 5.4.8 abrirá las herramientas de anotación. Estas 
herramientas y sus numerosas funciones se tratan con más detalle en la Sección 5.8.0. 

 

 

Almacenar en SACI 
El botón mostrado en la Figura 5.4.9 solamente funcionará cuando el sistema esté 
instalado en un centro médico con una red SACI. Para guardar sus archivos 
localmente, consulte la sección 5.7.0. 

 

Impresión en SACI 
El botón mostrado en la Figura 5.4.10 solamente funcionará cuando el sistema esté 
instalado en un centro médico con una red SACI. Para efectuar la impresión local, 
consulte la sección 5.7.0. 

 

Panel de control del dispositivo 
El botón mostrado en la Figura 5.4.11 abrirá el panel de control del dispositivo, lo 
que ofrecerá al usuario del dispositivo la oportunidad de controlar el sistema de 
rayos X mediante el software. El usuario podrá seleccionar fácilmente el modo de 
exposición, el ajuste de kV del tubo de rayos X, el tiempo de exposición y el número 
de imágenes que deberán obtenerse para el promediado de las imágenes (si lo 
desea), así como iniciar la exposición a los rayos X.  

Nota: El estado o la disponibilidad de los ajustes 
de la exposición se indica mediante las flechas 
arriba y abajo adyacentes al ajuste. Las flechas 
serán blancas para los ajustes activos y celestes 
para los inactivos. Los ajustes de la exposición que 
estén activos dependerán del modo de exposición 
seleccionado. 

La Figura 5.4.12 de la derecha muestra que se ha 
seleccionado el modo Full Auto (Totalmente 
automático) y que los promedios de kV, tiempo e 
imagen están todos activos. El usuario podrá 
ajustar cada una de estas configuraciones. 

 

Tenga en cuenta que, en el sistema Faxitron Path, 
la configuración de mA no se puede ajustar 
utilizando el software. La configuración de mA se 
mostrará como inactiva. 

Cuando termine, haga clic en el botón Request  
X-Rays (Solicitar rayos X) para adquirir una 
imagen o en el botón Set (Ajustar) para guardar la 
configuración y cerrar el panel de control del 
dispositivo. 

Si se hace clic en el botón Cancel (Cancelar), el 
panel de control del dispositivo se cerrará sin 
guardar ninguno de los cambios. 

 5.4.1 Cont.  
 
Figura 5.4.8 
Icono de Anotaciones  
 
 
  
 
Figura 5.4.9  
Icono de Guardar en SACI  
 
 
  
 
Figura 5.4.10  
Icono de Impresión en 
SACI  
 
 
  
 

Figura 5.4.11  
Icono de Volver al procedimiento 
 
 
 
 
Figura 5.4.12 
Panel de control del dispositivo 
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Volver al procedimiento 

El botón mostrado en la Figura 5.4.13 cierra el modo de obtención de imágenes y 
regresa a la pantalla del Home Menu (Menú de inicio).  

 

Apagado 
El botón mostrado en la Figura 5.4.14 cierra el software y apaga el sistema. 
 
 

Notas de diálogo adicionales 
 
Cuando se abre un diálogo, este se «acopla» a la izquierda de la pantalla. Si un usuario desea 
desacoplar el cuadro de diálogo, podrá hacer clic en el icono de «anclaje» superior derecho 
para desacoplar el cuadro de diálogo y poder arrastrarlo libremente. El «anclaje» se convertirá 
luego en un icono «X», que permitirá el cierre rápido. 
 
Los usuarios también pueden navegar rápidamente entre los distintos diálogos haciendo clic 
en el menú de la izquierda. Al hacerlo, el menú de la izquierda se cerrará rápidamente y abrirá 
los cuadros de diálogo correspondientes, según sea necesario. 

 

Barra de menú superior 
El software permite acceder a los menús «View» (Ver), «Tools» (Herramientas), «Image Tools» 
(Herramientas de imagen), «DICOM Utilities» (Utilidades de DICOM) y «Help» (Ayuda) 
mediante una barra de menú superior. Véase la Figura 5.4.15. La barra de menú superior está 
oculta de forma predeterminada y se muestra haciendo clic en el botón de flecha ubicado en 
la esquina superior derecha de la pantalla. Véase la Figura 5.4.16. El botón de flecha será 
blanco o negro, dependiendo de la página del software o el fondo de pantalla. Cada elemento 
del menú se tratará en detalle en las páginas siguientes. 

 

 

Nota: La flecha apuntará hacia abajo cuando la barra de menú superior 
esté oculta, y hacia arriba cuando esta se muestre. 

 

Menú Ver 
El menú «Ver» se encuentra en el menú principal superior y contiene los elementos del 
submenú mostrados en la Figura 5.4.17 siguiente. Cada elemento del submenú se describirá 
con más detalle en las próximas páginas. 

 

 

 

 5.4.1 Cont. 
 
Figura 5.4.13 
Icono de regreso al menú de 
inicio 
 
 
Figura 5.4.14 
Icono de apagado del sistema 
 
 
 
 
 
 
 
 
 
 
 
 
 
5.4.2 
Barra de menú 
superior 
 
 
 
 
 

Figura 5.4.15 
Barra de menú superior 
 
Figura 5.4.16 
Botones de la barra de menú 
superior 
 
 
5.4.3 
Menú Ver 
 
 
 
Figura 5.4.17 
Menú Ver 
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Modo Zoom 
 

Normal 
Muestra la imagen obtenida en su formato original. La imagen de los sistemas Faxitron Path 
supera el área de visualización de los monitores. En la esquina superior izquierda de la imagen 
se mostrará un cuadro de diálogo en miniatura que permitirá al usuario «panoramizar» la 
imagen. Consulte Ajuste del zoom dinámico en la Sección 5.4.1.  

 

Adjust Zoom (Ajustar el zoom) 
Esta opción está desactivada y no está disponible en este momento. 

 

Fit to Sample (Ajustar al espécimen) 
Esta opción adapta la imagen obtenida para que se ajuste mejor a la muestra de especímenes 
dentro del área de visualización del monitor. 

 

Fit All (Ajustar todos) 
Esta opción muestra toda la imagen obtenida, independientemente de cuál sea su formato 
original. La opción Full Resolution (Resolución completa) no funciona en este modo de vista. 

 

Fit Width (Ajustar anchura) 
Esta opción muestra la imagen obtenida a lo largo del ancho disponible de toda el área de 
visualización. 

 

Ajustar altura (Ajustar altura) 
Esta opción muestra la imagen obtenida a lo largo de la altura disponible de toda el área de 
visualización. 

 
Image Averages (Promedios entre las imágenes) 

Esta opción permite al usuario ajustar el número de promedios entre las imágenes que se 
tomarán por cada exposición. Las opciones disponibles son las tomas 1x, 2x, 4x u 8x. El ajuste 
predeterminado es la toma 1x. Si el usuario selecciona 2, 4 u 8 tomas, el software obtendrá el 
número de imágenes seleccionadas una detrás de otra pulsando el botón Start (Comenzar) 
una sola vez y promediará esas imágenes en una sola imagen. 

 

Image Perspective (Perspectiva de la imagen) 
Esta opción permite al usuario rotar la imagen visualizada a una orientación de 0, 90, 180 y 
270 grados. 
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Grid Options (Opciones de cuadrícula) 
Cuando se muestra una imagen, ya sea como una imagen obtenida o una imagen recuperada 
de la base de datos, el usuario podrá activar una cuadrícula. También permite al usuario 
establecer el espaciado (anchura) de la cuadrícula. Véase el ejemplo siguiente. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

User Window Levels (Niveles de la ventana de usuario) 
Esto permite al usuario definir hasta tres (3) niveles de la ventana (WL) prefijados y 
establecidos por el usuario. En primer lugar, seleccione el botón Window Level (Nivel de la 
ventana). Ajuste el WL al nivel deseado. En las herramientas «View» (Ver), seleccione «User 
Window Levels» (Niveles de ventana de usuario). Seleccione «Record Current WL» (Registrar 
WL actual) como USUARIO WL n.º 1, n.º 2 o n.º 3. El WL ajustado se guardará según la opción 
seleccionada previamente. 

Default Window Level (Nivel predeterminado de la ventana) 
El usuario tiene dos opciones de «Default Window Levels» (Niveles predeterminados de la 
ventana) (WL): «Optimize for whole area» (Optimizar para toda el área), que ajusta el WL para 
toda la imagen, u «Optimize for sample» (Optimizar para el espécimen), que ajusta el WL 
solamente para el área del espécimen. Además, existe la opción «Set Default Window Level» 
(Establecer el nivel predeterminado de la ventana), que se utiliza también para todas las 
imágenes obtenidas que se encuentran aquí. Esta establecerá el nivel predeterminado de la 
ventana en función de las estadísticas de la imagen, y deberá hacerse por separado para las 
imágenes no mejoradas y las mejoradas. 

Default Aspect of Raw Files (Aspecto predeterminado de los 
archivos sin procesar) 

Esta herramienta se encuentra bajo el menú VIEW (Ver). Ayuda a importar y abrir archivos de 
imágenes previamente guardados con atributos de archivo desconocidos o datos de imágenes 
binarios que no tienen ninguna información de encabezado. Dado que el tamaño exacto del 
conjunto del generador de imágenes no está disponible en el encabezado del archivo de datos 
de imagen, se usarán las dimensiones del generador de imágenes más adecuadas para 
importar o abrir dichas imágenes en función de que el ancho sea mayor o menor que la altura 
(información de aspecto predeterminada). 

Enhance Image (same as the Enhance Image button) (Mejorar la 
imagen [igual que el botón Mejorar la imagen]) 

Procesa la imagen actual del paciente y mejora la visualización del tejido situado cerca de la 
periferia de la muestra. 
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Figura 5.4.18 
Visualización de la cuadrícula de 
la muestra 
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Sample Viewer (Visor de muestras) 
En el caso de que el sistema tenga una cámara web, esta conmutará el visor de la cámara web 
del sistema para permitir la orientación y alineación de los especímenes. 
 

Review Layout (Disposición de la revisión) 
Ayuda al usuario a configurar múltiples paneles de imagen en Review (Database) Mode (Modo 
de revisión [de la base de datos]) del programa. Las opciones de disposición disponibles son:  
«(1 X 1) Single» (Simple), «(2 X 1) Double H» (Doble H), «(1 X 2) Double V» (Doble V), «(1 +  
(2 X 1) Triple» y «(2 X 2) Quadruple» (Cuádruple). Durante la operación con paneles múltiples, el 
usuario puede hacer clic una vez en el panel o la imagen deseada para realizar la selección 
actual; el panel seleccionado actual tendrá un borde rectangular verde alrededor. Las imágenes 
incluidas en la vista de lista de la base de datos o vista de miniaturas de la base de datos se 
abrirán en el panel seleccionado actual cuando se haga doble clic sobre ellas. El usuario también 
podrá abrir las imágenes en los paneles deseados directamente desde el menú contextual de las 
vistas de la base de datos mencionada. Después de activar el menú contextual, el usuario podrá 
seleccionar en los paneles listados bajo OPEN TO→ (ABRIR HACIA), que proporcionará los 
paneles disponibles para abrir la imagen (izquierda, derecha, arriba, abajo, etc.). 
 

Menú Tools (Herramientas) 
El menú «Tools» (Herramientas) está ubicado en la barra de menú superior, situada en la 
esquina superior izquierda de la pantalla principal. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Preferences (Preferencias) 
El menú «Preferences» (Preferencias) abre una utilidad de gestión de la configuración que 
permite cambiar varias opciones o parámetros. 

Nota: La herramienta «Preferences» (Preferencias) está protegida mediante contraseña y 
solamente puede acceder a ella un representante autorizado del servicio técnico de Hologic. 

Nota: Cambiar los parámetros de configuración sin los conocimientos ni la autorización 
pertinentes podrá causar la pérdida de calidad de las imágenes, daños en el sistema y 
funcionamiento incorrecto del sistema. 

Modo Service (Modo de mantenimiento) 
El «Service Mode» (Modo de mantenimiento) está protegido mediante contraseña y lo activan 
técnicos autorizados de Hologic para resolver problemas. 

Service Tools (Herramientas de mantenimiento) 
«Service Tools» (Herramientas de mantenimiento) suelen aparecer sombreadas en gris. 
Solamente se enciende cuando el sistema está en «Service Mode» (Modo de mantenimiento). 
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5.4.4 
Menú Herramientas 
 
 
Figura 5.4.19 
Menú Herramientas 
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Save Reference Files (Guardar archivos de referencia) 
La opción «Save Reference Files» (Guardar archivos de referencia) suele aparecer 
sombreada en gris. Solamente se enciende cuando el sistema está en «Service Mode» 
(Modo de mantenimiento). 

Opción Advanced Tools (Herramientas avanzadas) 
Las «Advanced Tools» (Herramientas avanzadas) ofrecen varias opciones para configurar 
aspectos del software tales como el post-procesamiento y las opciones de configuración. 

Auto Save On/Off (Guardar el encendido y apagado automático) 
Cuando «Auto save» (Guardar automáticamente) está «activado», todas las imágenes 
obtenidas posteriormente se guardarán en la base de datos. Los archivos se escribirán en un 
directorio de datos definido en el archivo de configuración. 

X-Ray Calibration/Exposure Set-up (Calibración de los rayos 
X/Configuración de la exposición) 

Se encuentran en Advanced Tools (Herramientas avanzadas). «X-Ray Calibration/Exposure 
Setup» (Calibración de los rayos X/Configuración de la exposición) ayuda al usuario a 
determinar el tiempo de exposición adecuado para un determinado ajuste de kV que obtenga 
la mejor calidad de las imágenes. Consulte en la sección 5.2.0 y la Figura 5.2.1 una descripción 
más detallada.  

 

Configuración del CAE de la exposición de una toma previa 
El sistema Faxitron Path utiliza el control automático de la exposición (CAE) para proporcionar 
la mejor calidad posible de las imágenes pulsando el botón Start X-Ray (Comenzar radiografía) 
una sola vez. El software utilizará una exposición de una Preshot (Toma previa) para calcular 
los ajustes óptimos de la exposición en kV y tiempo. La toma previa es una exposición breve a 
los rayos X, normalmente de 2 a 3 segundos. El software analizará los resultados para 
determinar los kV y el tiempo necesarios para producir la mejor calidad de las imágenes. La 
exposición al CAE de una toma previa se configura en fábrica y se activa de forma 
predeterminada. 

«Preshot AEC Exposure Setup» (Configuración del CAE de la exposición de una toma previa) 
permite al usuario ajustar el sistema a determinados requisitos de obtención de imágenes o 
para compensar el envejecimiento del sistema. 

Para acceder al cuadro de diálogo «Preshot AEC Exposure Setup» (Configuración del CAE de 
la exposición de una toma previa), vaya a la barra de menú superior, seleccione «Tools» 
(Herramientas), «Advanced Tools» (Herramientas avanzadas) y, a continuación, «PRESHOT 
AEC Exposure Setup» (Configuración del CAE de la exposición de una toma previa). Véase la 
Figura 5.4.19. 
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Introduzca los valores de PRESHOT 
AEC (CAE DE LA TOMA PREVIA) 
en la ventana que se muestra a la 
derecha. 
 
Para el ajuste de las tomas previas, 
los ajustes mostrados reflejan un 
tiempo de exposición de 26 kV y 
3 segundos con una intensidad 
objetivo de 10.000 UAD. Los 
usuarios pueden introducir la 
selección de parámetros de la toma 
previa seleccionando solamente 
DYNAMIC METHOD (MÉTODO 
DINÁMICO) en la sección 
ANALYSIS METHOD (MÉTODO DE 
ANÁLISIS). La selección de STATIC 
METHOD (MÉTODO ESTÁTICO) 
utilizará parámetros predefinidos por 
Faxitron. Además, el usuario tendrá 
la opción de seleccionar los ajustes 
de kV y tiempo de exposición en la 
sección EXPOSURE TUNING 
METHOD (MÉTODO DE AJUSTE 
DE LA EXPOSICIÓN). 
 
Para obtener unas imágenes más 
precisas, el usuario podrá introducir 
el grosor de SOFT TISSUE (Sample) 
(TEJIDO BLANDO [Muestra]) y 
TARGET INTENSITY (INTENSIDAD DEL OBJETIVO) en las UAD. Nota: Los valores de la 
imagen superior son solo un ejemplo. Es necesario determinar los valores correctos. 
 
Nota: Los valores en la imagen superior son los típicos para el sistema Faxitron Path. Deberá 
determinar los valores exactos para su sistema. 
 
Para el modo AUTOMATIC EXPOSURE CONTROL (CONTROL DE LA EXPOSICIÓN 
AUTOMÁTICA), pulse el botón Start (Comenzar) en el software Vision (o en el panel de 
control). Para crear una región de interés (ROI) y obtener los parámetros de exposición para la 
exposición óptima de la imagen, el software Vision realizará una toma previa (exposición previa 
a una dosis breve y baja) de la muestra. 
 
 

Utilidad Login (Inicio de sesión) 
 
La Login Utility (Utilidad de inicio de 
sesión) que está en el menú 
ADVANCED TOOLS (Herramientas 
avanzadas) permite al usuario 
configurar y activar la autenticación con 
contraseña de inicio del software Vision. 
En el sistema Faxitron Path, la 
activación de esta función es opcional. 
Si el usuario activa la autenticación con 
contraseña, se le pedirá cada vez que 
abra el programa. Si no se introduce la 
contraseña correcta, el programa se 
cerrará. 

 

 5.4.4 Cont. 
 
Figura 5.4.20 
Cuadro de diálogo Preshot AEC 
Setup (Configuración del CAE de 
una toma previa) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.4.21 
Login Utility (Utilidad de 
inicio de sesión). En la 
autenticación del inicio 
aparecerá esta misma 
pantalla. 
 
 



 
  

MANUAL DE USUARIO DE FAXITRON PATH | HOLOGIC | REVISIÓN 025   
 

SECCIÓN 
Software 
VISION 5 

5-22 

Faxitron® Path 
Sistema de radiografía de muestras 

Properties (Propiedades) 
«Properties» (Propiedades) oculta o muestra el cuadro de información de la imagen. Véase la 
Figura 5.3.9. 
 

Edit Current Image Record (Editar el registro de imagen actual) 
Actualmente no se utiliza. 
 
Delete Current Image Record (Eliminar registro de imagen actual) 
Elimina la imagen actual del directorio de archivos, tal y como se especifica en el archivo de 
configuración. 
 
Add Current Image Record (Agregar registro de la imagen actual) 
Añade la imagen actual al directorio de archivos, tal y como se especifica en el archivo de 
configuración. 
 

Capture Screen Shot JPG/BMP (Realizar captura de pantalla en 
JPG/BMP) 

Seleccionando esta opción del menú, el usuario puede realizar una captura de pantalla de la 
ventana activa mostrada. El usuario puede especificar un nombre de archivo y elegir entre 
JPG y BMP como formato de archivo guardado. 
 
Save/Store Current Image (Guardar o almacenar la imagen actual) 
El usuario puede «navegar» hasta el directorio o la carpeta de archivos en la que desee 
guardar la imagen. Deberá asignarse un nombre de fichero en el campo proporcionado. 
Seleccione un formato de tipo de archivo en el que guardar la imagen. Se proporcionan 
numerosos tipos de archivo. Para guardar el archivo en formato DICOM, consulte la sección 
«DICOM Functionality» (Funcionalidad DICOM). 

Print Current Image (Imprimir imagen actual) 
Imprime la imagen actual en la impresora de WINDOWS. 
 

Image Tools (Herramientas de imagen) 
Para editar la imagen obtenida o recuperada, están disponibles las siguientes funciones 
haciendo clic en el menú «Image Tools» (Herramientas de imagen). Véase la Figura 5.4.22.  
Con un solo clic sobre la opción deseada, se podrá acceder 
a o activar las opciones del submenú. 
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5.4.5 
Herramientas de 
imagen 
 
 

Figura 5.4.22 
Menú Herramientas de imagen 
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Original Contrast (Contraste original) 

«Original Contrast» (Contraste original) restaura los niveles de contraste de la imagen. Esto 
sirve para el mismo propósito que el botón Original Contrast (Contraste original) en la 
herramienta Window Level and Contrast (Nivel de la ventana y contraste). Véanse la  
Sección 5.4.1 y la Figura 5.4.3. 

Invert (Invertir) 
«Invert» (Invertir) hace que la imagen visualizada se invierta o revierta. Al invertir una imagen, 
se invierte su transparencia: lo que es negro se convierte en blanco y lo que es blanco se 
convierte en negro. A los grises se les asigna su transparencia espejo. Para desactivar la 
función, haga clic de nuevo en «Invert» (Invertir). Realiza la misma función que el botón Invert 
(Invertir). Consulte la Sección 5.4.1 y las Figuras 5.4.3 y 5.4.4. 

Ampliar 
«Magnify» (Ampliar) permite al usuario ampliar un área de interés. Para utilizar la función Magnify 
(Ampliar), sitúe el cursor del ratón sobre el área que desee ampliar y haga clic con el botón 
izquierdo del ratón. Se ampliará el área de interés. Para desactivar la función, haga clic de nuevo 
en «Magnify» (Ampliar). Consulte la Figura 5.4.23. El usuario podrá ajustar el tamaño del área de 
interés ampliada. Consulte el submenú «Magnifier Size» (Tamaño de la lupa) en la Sección 5.4.3. 

 

 

 

 

 

 

 

 

 

 

 
 

Edge Enhance (Realce de los bordes) 
«Edge Enhance» (Realce de los bordes) definirá con mayor nitidez los bordes de las regiones 
utilizando una diferencia de contraste. Puede que el realce de los bordes amplifique el ruido en 
las imágenes en general. Seleccionando de nuevo la opción del menú, se desactivará el realce 
de bordes. Si hace clic en «Original Contrast» (Contraste original), la imagen volverá a su 
estado original. Tenga en cuenta que esta es una función diferente a la función Enhance Image 
(Mejorar la imagen) de la Sección 5.4.1 y 5.4.3. 

ROI Contrast (Contraste de la ROI) 
«ROI Contrast» (Contraste de la ROI) optimizará los niveles de contraste del interior de una 
región de interés (ROI) definida por el usuario. Después de seleccionar «ROI Contrast» 
(Contraste de la ROI), haga clic y mantenga pulsado el botón izquierdo del ratón en el punto 
inicial de la ROI deseada, arrastre el ratón y suelte el botón del ratón en el punto final de la ROI 
deseada. El contraste se ajustará automáticamente a los mejores niveles para esa ROI. (Para 
más información sobre la ROI, consulte la sección Definiciones). 

ROI Window Level (Nivel de ventana de la ROI) 
La función «ROI Window Level» (Nivel de ventana de la ROI) no está disponible en la versión 
actual del software Vision. 
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Figura 5.4.23 
Ampliar 
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Regla 

«Ruler» (Regla) permite al usuario medir la distancia entre dos puntos de la imagen visualizada. 
Las medidas de longitud se expresan en milímetros (mm). Después de seleccionar «Ruler» 
(Regla), haga clic y mantenga pulsado el botón izquierdo del ratón y, empezando por el punto 
inicial de la medición, arrastre el ratón y suelte el botón del ratón en el punto final de la medición. 
En la imagen, la regla tiene el aspecto de una línea roja. 
 
La medición (en mm) se muestra al 
final de la regla. Hasta que el 
usuario seleccione otra 
herramienta de imagen o hasta 
que se realice otra acción, la regla 
permanecerá activa. Véase la 
Figura 5.4.24 a la derecha. Para 
desactivar la función, haga clic de 
nuevo en «Ruler» (Regla). 
 
Sugerencia: para obtener una 
línea perfectamente recta o una 
línea en un ángulo perfecto de 45 
grados, mantenga pulsada la tecla 
SHIFT (del teclado) mientras 
mantiene pulsado el botón 
izquierdo del ratón y arrastre. 
 

Estadísticas de la ROI 
«ROI Statistics» (Estadísticas de la ROI) mostrará un cuadro de diálogo que contiene estadísticas 
de la imagen. Haga clic y mantenga presionado el botón izquierdo del ratón sobre la región de 
interés (ROI) de la imagen principal, arrastre el cursor para hacer la selección alrededor del área 
y luego suelte el botón del ratón. La información estadística de la región seleccionada se mostrará 
en el lado izquierdo del cuadro de diálogo y la de toda la imagen, en el lado derecho del recuadro. 
Las estadísticas que se muestran son: los puntos inicial y final de la ROI, los valores de intensidad 
Minimum (Mínimo), Maximum (Máximo) y Mean (Medio) y Standard Deviation (Desviación 
estándar) (STD). Para cerrar el cuadro de información Statistics (Estadísticas), simplemente haga 
clic en el botón Close (Cerrar). Véase la Figura 5.4.25. Para desactivar la función, haga clic de 
nuevo en «ROI Statistics» (Estadísticas de la ROI). 
 
 
 

 5.4.5 Cont. 
 
 
 
 
 
 
Figura 5.4.24 
Regla 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.4.25 
Estadísticas de la ROI 
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Histograma de la ROI 
«ROI Histogram» (Histograma de la ROI) creará un histograma para una ROI definida por el 
usuario. Después de seleccionar la opción del menú, coloque el cursor del ratón en la imagen 
visualizada, mantenga pulsado el botón izquierdo del ratón y arrástrelo para seleccionar la ROI 
deseada. Suelte el botón del ratón. Se mostrarán histogramas de la ROI seleccionada. Véase 
la Figura 5.4.6. 

La curva negra es el histograma de la región seleccionada. La curva azul es el histograma de 
toda la imagen. Ambas curvas se normalizan contra el valor máximo de píxeles de la región de 
interés seleccionada. Para desactivar la función, haga clic de nuevo en «ROI Histogram» 
(Histograma de la ROI). 

 

 

 

 

 

 

 

 

 

 

 

Perfil de la ROI 
«ROI Profile» (Perfil de la ROI) creará un perfil para una ROI definida por el usuario. Después de 
seleccionar la opción del menú, coloque el cursor en la imagen visualizada. Para dibujar un 
cuadro definido por el usuario alrededor de la ROI deseada, mantenga pulsado el botón izquierdo 
del ratón y mueva el cursor por la imagen. Suelte el botón izquierdo del ratón y aparecerá un perfil 
que mostrará los valores de cada píxel de la ROI definida. Véase la Figura 5.4.27. Por defecto, 
la dirección de la promediación de la ROI seleccionada es el eje corto. El eje puede desplazarse 
hacia adelante y hacia atrás seleccionando el botón SWITCH, HOR<->VERT (CAMBIAR 
HORIZONTAL<->VERTICAL). Para desactivar la función, haga clic de nuevo en «ROI Profile» 
(Perfil de la ROI). 
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Figura 5.4.26 
Histograma de la ROI 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.4.27 
Perfil de la ROI 
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Perfil de la línea 
«Line Profile» (Perfil de la línea) mostrará el perfil de una línea definida por el usuario. Después 
de seleccionar «Line Profile» (Perfil de la línea), coloque el cursor en la imagen visualizada. 
Para dibujar una línea definida por el usuario, mantenga pulsado el botón izquierdo del ratón y 
mueva el cursor por la imagen. Suelte el botón izquierdo del ratón y aparecerá un perfil que 
mostrará los valores de cada píxel de la línea definida. Véase la Figura 5.4.28. Por defecto, el 
primer punto seleccionado es siempre la parte izquierda (más cercana al origen) del gráfico (es 
decir, el eje horizontal del gráfico puede tener índices de píxeles (i, i) crecientes o decrecientes, 
dependiendo de los puntos inicial o final que se hayan seleccionado). Para desactivar la 
función, haga clic de nuevo en «Line Profile» (Perfil de la línea). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Nivel de ventana incorporado 
El software Vision incluye una función de Window Level (Nivel de ventana) «incorporado». Para 
seleccionarlo, no hay ningún botón ni elemento del menú. La función Window Level (Nivel de 
ventana) se activa automáticamente cada vez que se obtiene una imagen o se recupera de la 
base de datos para revisarla. Esta función permite al usuario ajustar los niveles de contraste y 
brillo de la imagen utilizando el ratón o el cursor. 

Para ver los niveles de brillo u oscuridad, haga clic y mantenga pulsado el botón izquierdo del 
ratón sobre la imagen visualizada y mueva el cursor hacia arriba y hacia abajo, o mueva el 
cursor hacia la izquierda o hacia la derecha para subir o bajar el contraste. Mueva el cursor 
hasta que la imagen se encuentre en los niveles deseados. 
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Figura 5.4.28 
Perfil de la línea 
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Presionando el botón, mostrado en la Figura 5.5.1 y ubicado en la parte inferior de la ventana 
de obtención de imágenes, aparecerá la secuencia de imágenes en miniatura del paciente 
actual. Véase la Figura 5.5.2. 
 
 
 
 
 
 

 
 
 
En texto naranja y a lo largo de la parte superior, la secuencia de miniaturas mostrará la fecha 
en la que se realizó el procedimiento de cada serie de imágenes individuales. 

Se iluminará en verde la imagen actual que aparece mostrada en la ventana de obtención de 
imágenes. 

Para colocar las imágenes en la pantalla o en los paneles de revisión, la secuencia de 
miniaturas permite realizar las operaciones «arrastrar» y «soltar», según sea necesario. 

Además, con un solo clic, el usuario podrá seleccionar varias imágenes y, a continuación, 
seleccionar entre las diferentes opciones para guardar las imágenes en una unidad USB, enviar 
las imágenes al SACI o borrar las imágenes. Las imágenes seleccionadas aparecerán 
resaltadas en naranja. 

Hay flechas situadas a la izquierda y a la derecha. En caso de que se tomen gran cantidad de 
imágenes, pulsando las flechas izquierda o derecha el usuario podrá recorrer por fecha 
ascendente las imágenes tomadas.  

También se incluye la opción Open the Database (Abrir la base de datos) (véase la 
Figura 5.5.3), que entra en el modo Review (Revisión). Este mismo botón es el equivalente a 
pulsar Review Mode (Modo de revisión) en Home Menu (Menú de inicio). Véanse las  
Figuras 5.0.1 y 5.6.1. 

 
Se puede entrar en el modo de revisión haciendo clic en el botón Review (Revisar) de la página 
Home Menu (Menú de inicio), Figuras 5.6.1 y 5.0.1, o en el botón Open Database (Abrir base 
de datos) de Current Image Browser (Explorador de imágenes actuales). Véase la Figura 5.5.3. 
Al hacer clic en cualquiera de estos botones, se abrirá la base de datos como 
se muestra en la Figura 5.6.2. Mientras esté en modo de revisión, el sistema 
estará en modo de espera. 
 
 
 
La base de datos se compone básicamente de tres secciones o subventanas. La sección 
Patient List Table (Tabla de la lista de pacientes) a la izquierda, la sección Procedure List Table 
(Tabla de la lista de procedimientos) en la parte superior derecha y la sección Image Thumbnail 
List/Viewer (Lista/Visor de imágenes en miniatura) en la parte inferior derecha. 

 

 5.5.0 
Explorador de 
imágenes del 
paciente actual 
 
Figura 5.5.1 
Icono del explorador de imágenes 
del paciente actual 
 
Figura 5.5.2 
Explorador de imágenes del 
paciente actual 
 
Figura 5.5.3 
Botón de la base de datos de las 
imágenes 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5.6.0 
Base de datos 
 
Figura 5.6.1 
Icono del modo Review (Revisión) 
del menú de inicio 
 
 
 
 
 
 
 
 
Figura 5.6.2 
Base de datos de las imágenes 
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Como indica la flecha, las tablas de listas funcionan en una jerarquía de arriba hacia abajo: 
The Patient List (Lista de pacientes) ---> Procedure List (Lista de procedimientos) ---> Image 
Thumbnail List/Viewer (Lista/Visor de imágenes en miniatura). 
La ventana de selección Patient (Paciente) es la ventana superior izquierda. La ventana 
Procedure (Procedimiento) es la ventana superior derecha. 
Cuando se selecciona un campo Patient (Paciente), se activa la ventana Procedure 
(Procedimiento). La ventana Procedure (Procedimiento) muestra una lista de todos los 
procedimientos realizados en el paciente seleccionado. Además, todas las imágenes 
correspondientes al paciente se mostrarán en la parte inferior derecha. No es posible 
seleccionar a varios pacientes. 
Cuando se selecciona un procedimiento, la lista de imágenes en miniatura/visor se filtrará para 
mostrar solamente las imágenes que corresponden al procedimiento seleccionado. Se pueden 
seleccionar varios procedimientos manteniendo pulsada la tecla Mayúsculas y haciendo clic 
con el botón izquierdo del ratón en cada procedimiento. Se mostrarán las imágenes 
correspondientes de los procedimientos seleccionados. 
• Puede ajustarse la elección en la base de datos haciendo clic en los campos superiores, como 

Patient ID (ID de paciente) y Last Name (Apellido), para ordenarla por uno u otro campo. 
Cuando se haga clic con el cursor del ratón sobre uno de los campos de la base de datos, se 
mostrará un pequeño indicador de flecha dentro del campo. Usando el botón izquierdo del ratón 
y seleccionando el campo de nuevo, la flecha cambiará de ascendente a descendente o 
viceversa. El campo seleccionado correspondiente se ordenará automáticamente. 

• Para facilitar la navegación, hay barras de desplazamiento en la base de datos. 

• Para añadir automáticamente la imagen a un panel de revisión, la lista de miniaturas/visor 
permite al usuario hacer clic en el símbolo «+». Un usuario puede añadir hasta cuatro 
imágenes en los paneles de revisión. Los paneles de revisión se ajustarán automáticamente 
para abarcar las cuatro imágenes. 

• Las mismas opciones disponibles en Current Patient Images Browser (Explorador de 
imágenes del paciente actual) (véase la Figura 5.5.2) están también ubicadas en la parte 
superior de la base de datos. No obstante, también se ofrecen más opciones, que aparecen 
descritas en la Sección 5.5.2. 

Nota importante: las imágenes en miniatura (.PNG) son archivos independientes de los 
archivos de datos de imagen reales (DCM, DAT, DMM, RAW). Tienen el mismo nombre de 
archivo que el archivo de imagen, pero tienen una extensión de archivo (.PNG). Puede que 
haya un archivo de imagen sin «miniatura». En ese caso, Vision intentará crear una miniatura 
automáticamente para que la imagen se cargue en la base de datos. Sin embargo, si esto no 
se pudiera hacer, la imagen no se mostrará. 

 

Save Image(s) (Guardar imágenes) 
El botón Save Image(s) (Guardar imágenes) aparece al seleccionar una entrada de Image 
Table (Tabla de imágenes) o Thumbnail List (Lista de imágenes en miniatura), o en las 
imágenes del paciente actuales; de lo contrario, se desactivará. La imagen seleccionada se 
podrá guardar en los siguientes formatos de 8 bits: JPEG, BMP, TIFF y RAW. También se 
podrá guardar en formato TIFF de 16 bits. 

El nivel de ventana de la imagen guardada es el nivel de ventana predeterminado. Si el usuario 
requiere que el nivel de la ventana esté organizado, deberá cargar la imagen en Image View 
(Vista de imagen) e imprimir desde allí, en lugar de imprimir desde el cuadro de diálogo de la 
base de datos. 

 

Send Image(s) to PACS (Enviar imágenes al SACI): 
Esta función envía las imágenes a un servidor SACI de DICOM preconfigurado. Para obtener 
más información, consulte la Sección 5.7.0. 

 5.6.0 Cont. 
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Funciones y herramientas del menú de la base de datos o de 
imágenes 

Hay funciones para explorar y buscar en la base de datos, 
así como para editar, borrar y añadir registros a la base de 
datos. Estas funciones se explican a lo largo de los 
elementos del menú de la base de datos. Se accede a ellas 
desde el botón de nivel superior denominado Additional 
Options (Opciones adicionales) dentro de la base de datos. 

 

 

 

Menú Open (Abrir) 
El menú «Open» (Abrir) solamente tiene una opción, «Open Image from File» (Abrir imagen 
desde archivo), que abre un cuadro de diálogo de Windows que permite al usuario navegar y 
abrir archivos de imagen ubicados en unidades locales o de red. 
 

Menú Print (Imprimir) 
El menú «DB-PRINT» 
(IMPRIMIR BASE DE DATOS) 
ofrece la función de impresión 
de imágenes, procedimientos o 
pacientes. Véase la Figura 4.6.4. 

 

Print Image to Local Printer (Imprimir imagen en la impresora local) 
«Print Image to Local Printer» (Imprimir imagen en la impresora local) está disponible cuando 
se selecciona la entrada en la tabla de imágenes o en la lista de imágenes en miniatura; de lo 
contrario, estará desactivada. La imagen seleccionada se imprimirá utilizando la impresora 
local predeterminada del sistema Windows. 

El nivel de ventana de la imagen impresa es el nivel de ventana predeterminado. No se 
recomienda que los usuarios impriman desde este menú, a menos que estén satisfechos con 
las impresiones establecidas en los niveles de ventana predeterminados y calculados por el 
programa. El usuario podrá cargar la imagen primero en la ventana Image View (Review) (Vista 
de imagen [Revisión]) y luego ajustar la imagen a los niveles de ventana deseados. Cuando 
esté satisfecho con el nivel de la ventana, el usuario podrá iniciar la impresión desde el menú 
de la ventana de Image View (Vista de imagen). El cuadro de diálogo Format Options (Opciones 
de formato) ofrece la posibilidad de elegir entre formatos de impresión. 

Print Image(s) to DCM Printer (Imprimir imágenes en una 
impresora DCM) 

Esta función envía las imágenes a una impresora DICOM preconfigurada. 

Menú View (Ver) 
El menú «View» (Ver) ofrece al usuario una serie de opciones que afectan a la vista de la base 
de datos. Véase la Figura 5.6.5. 
 
 
 
 
 
 

 5.6.1 
Opciones 
adicionales de la 
base de datos 
 
Figura 5.6.3 
Menú Additional Options 
(Opciones adicionales) 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.6.4 
Menú Impresión de la base de 
datos 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.6.5 
Menú Ver base de datos 
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Show All DB Entries (Mostrar todas las entradas de la base de datos) 
Recarga la tabla de pacientes desde el archivo de base de datos. Cualquier cambio o adición a 
la base de datos se aplicará a la tabla. Esta selección también borrará cualquier Search Filter 
(Filtro de búsqueda) activo que se haya aplicado a las tablas. Search Filter (Filtro de búsqueda) 
se explica a continuación en detalle en el tema Database Search (Búsqueda en la base de datos). 

Refresh DB Entries (Actualizar entradas de la base de datos) 
Actualiza la tabla Patient (Paciente), pero mantiene cualquier filtro de búsqueda existente que 
se haya aplicado. 

Browse Data Directory (No DB) (Explorar el directorio de datos 
[no la base de datos]) 

Muestra todas las imágenes en miniatura en el directorio Data (Datos) establecido por el 
archivo de configuración. Estos archivos se muestran en el Visor de miniaturas. No están 
asociados a la base de datos ni a las listas de tablas. Esta herramienta es útil para revisar 
imágenes no grabadas o para depurar problemas de la base de datos con imágenes en el 
directorio de datos actual. 

Browse Any Directory (No DB) (Explorar cualquier directorio [no 
la base de datos]) 

Permite al usuario navegar a cualquier directorio de archivos. Estos archivos se muestran en 
el Visor de miniaturas. No están asociados a la base de datos ni a las listas de tablas. Esta 
herramienta es útil para revisar un directorio de imágenes que nunca fue grabado en la base 
de datos, o cuando los registros de la base de datos están dañados. 

Menú de búsqueda 
Las herramientas de «Search» (Búsqueda) de la base de datos, véase la Figura 5.6.6, 
proporcionan búsquedas detalladas o filtrado de la base de datos. Seleccionando el menú «DB-
Search» (Búsqueda en la base de datos) el usuario puede realizar una búsqueda detallada y 
específica. Cuando se introducen y activan los criterios de búsqueda en el cuadro de diálogo de 
búsqueda de la base de datos, véase la Figura 5.6.7, el filtro de búsqueda se aplicará a todas las 
tablas de listas del cuadro de diálogo de la base de datos de imágenes. El criterio de búsqueda 
activado se denomina Search Filter (Filtro de búsqueda) y este filtro permanece activo hasta que 
el usuario selecciona «Stop Search» (Detener búsqueda) en el menú «DB-Search» (Búsqueda 
en la base de datos) o «Show All DB Entries» (Mostrar todas las entradas de la base de datos) 
en el menú «DB-View» (Vista de 
la base de datos). El filtro de 
búsqueda activo siempre se 
muestra en el título del cuadro de 
diálogo Image Database (Base 
de datos de imágenes). 

Start Search (Iniciar búsqueda) 
«Start Search» (Iniciar búsqueda) abre el diálogo de búsqueda de la base de datos que permite 
al usuario colocar un filtro de búsqueda activo en la base de datos. Cuando se abre el diálogo 
de búsqueda, se cierra la página 
Database (Base de datos) y el 
software vuelve a la página 
Image Acquisition (Obtención de 
imágenes). La página Database 
(Base de datos) se reabrirá 
automáticamente después de 
cerrar el cuadro de diálogo 
Search (Buscar). 

Los menús desplegables proporcionan una lista de las categorías de búsqueda. Seleccione 
una categoría de búsqueda y escriba el parámetro de búsqueda deseado para iniciar la 
búsqueda. Para iniciar la búsqueda, seleccione «Start» (Comenzar). Si la categoría puede 
tener más de una entrada discreta, se mostrarán todas las entradas de esa categoría.  

 5.6.1 Cont. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.6.6 
Menú de búsqueda en la base de 
datos 
 
 
 
 
 
 
 
 
Figura 5.6.7 
Cómo iniciar una búsqueda en la 
base de datos 
 
 



 
  

MANUAL DE USUARIO DE FAXITRON PATH | HOLOGIC | REVISIÓN 025   
 

SECCIÓN 
Software 
VISION 5 

5-31 

Faxitron® Path 
Sistema de radiografía de muestras 

Stop Search (Detener la búsqueda) 
«Stop Search» (Detener la búsqueda) desactiva cualquier filtro de búsqueda activo, borra todas 
las tablas de la lista y vuelve a cargar la lista de todos los pacientes a la tabla de lista de pacientes. 

Menú Tools (Herramientas) 
El menú «DB-Tools» ofrece funciones de imagen, procedimiento o paciente, así como algunas 
funciones útiles para reparar o reformatear la base de datos. 

 

 

 

 

Edit Image Record (Editar registro de imagen) 
La función «Edit Image Record» (Editar registro de imagen) no está disponible actualmente en 
el software Vision. 

Add Record to DB (Añadir registro a la base de datos) 
Disponible cuando se selecciona la entrada de Image Table (Tabla de imágenes) o de 
Thumbnail List (Lista de imágenes en miniatura); de lo contrario, estará desactivada. Esto es 
especialmente útil cuando se navega por un directorio sin que la base de datos tenga entradas 
disponibles para las imágenes en ese directorio. El usuario puede seleccionar una sola imagen 
de la lista de miniaturas y añadir registros de esa imagen a la base de datos. Si la entrada de 
la base de datos ya existe para la imagen seleccionada, no causará ningún daño; solamente 
puede actualizar la base de datos en términos de dónde se encuentra actualmente el archivo 
de imagen, es decir, el nombre del archivo/carpeta. 

Import Records in DIR to DB (Importación de registros del 
directorio a la base de datos) 

Esta herramienta ayuda a buscar y seleccionar una carpeta y, a continuación, a rellenar la base 
de datos con todas las entradas correspondientes para todos los archivos de imagen del 
directorio seleccionado (incluidos los subdirectorios). Los formatos de las imágenes pueden 
ser DCM, DAT, DMM y RAW. Si faltan miniaturas de imágenes, esta herramienta también 
generará miniaturas de BMP en el mismo directorio. 

Reformat All DB (Reformatear toda la base de datos) 
La herramienta «Reformat All DB» (Reformatear toda la base de datos) ayuda a reformatear 
los campos Date [YYYY/MM/DD] (Fecha [AAAA/MM/DD]), Date/Time [YYYY/MM/DD 
HH:MM:SS] (Fecha/Hora [AAAA/MM/DD HH:MM:SS]) de las tablas, y también escribe en 
mayúsculas las letras de las entradas de algunos otros campos. Es una herramienta útil cuando 
algún archivo de base de datos más antiguo se importa y abre por primera vez, o cuando el 
usuario altera manualmente las entradas de la base de datos utilizando MS Access. 

 
Notas adicionales en la base de datos 

• La posibilidad de salir de la base de datos permaneciendo dentro del modo Revisión se 
encuentra en Additional Options (Opciones adicionales). 

• El botón de la parte superior izquierda se ajustará para llevar al usuario Back to Acquisition 
(De vuelta a la obtención), Back to the Main Menu (De vuelta al menú principal) o se convertirá 
en el botón Close Database (Cerrar base de datos), dependiendo del flujo de trabajo utilizado 
para entrar en la pantalla Database (Base de datos) y de lo que sea más conveniente. 

 5.6.1 Cont. 
 
 
 
 
 
 
 
 
Figura 5.6.8 
Menú Herramientas de la base de 
datos 
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Editar o eliminar de la base de datos la información sobre el paciente 
El usuario puede editar o borrar la información sobre el paciente desde la base de datos. Para 
abrir un cuadro de diálogo, haga clic con el botón derecho en la entrada del paciente situada 
en la sección superior de la base de datos. Véase la Figura 5.6.9. 

 

Al hacer clic en «Edit Patient Information» (Editar 
información sobre el paciente), se abrirá un 
cuadro de diálogo «Patient Information» 
(Información sobre el paciente). Véase la Figura 
5.6.10. Para volver a la base de datos sin realizar 
ni guardar los cambios, haga clic en Cancel 
(Cancelar). Al hacer clic en Save Changes 
(Guardar cambios), se abrirá un cuadro de diálogo de «Confirmation» (Confirmación). Para 
confirmar y continuar, haga clic en Yes (Sí). Los cambios se guardarán y el usuario volverá a 
la base de datos. No anulará los cambios y volverá a la base de datos. Cancel (Cancelar) 
regresará al usuario al cuadro de diálogo «Patient Information» (Información sobre el paciente). 

Nota: Si el sistema tiene activada una contraseña de puesta en marcha (consulte el tema Login 
Utility [Utilidad de inicio de sesión] en la Sección 5.4.4 y la Figura 5.4.21), se le pedirá la misma 
contraseña cuando intente «Delete Patient Information» (Eliminar la información sobre el 
paciente) en la base de datos. 

 

El estándar DICOM 
¿Qué es el estándar DICOM? 

El Estándar de Imagenología Digital y Comunicaciones en Medicina (DICOM) es una serie de 
protocolos utilizados por equipos y software médicos para permitir que los datos sean 
compatibles e intercambiables con otros equipos o software médicos. 

Cuando se guarda un archivo en formato DICOM, se crea un archivo que incluye los datos 
relevantes del paciente, el equipo de obtención de imágenes, los datos del hardware y los datos 
de las imágenes, todo en un solo archivo. Además, el archivo guardado contiene características 
específicas identificadas por el ordenador y el software como archivo de estándar DICOM. Una 
vez que una aplicación de software reconoce el archivo como un archivo de estándar DICOM, 
puede iniciar un lector DICOM y extraer los datos correctamente, independientemente del 
origen del archivo.  

Un archivo creado utilizando el protocolo DICOM tiene la siguiente estructura:  

 
 
Cuando el preámbulo consta de 128 bytes, todos ellos 
normalmente configurados en 00H, a menos que no sean 
utilizados por un perfil de aplicación o una implementación 
específica, el prefijo consta de 4 bytes, que constituyen la cadena 
de caracteres «DICM» codificada como caracteres en mayúscula 
del repertorio de caracteres ISO 8859 G0, y los elementos de los 
datos son arbitrariamente grandes (o pequeños) y contienen los 
datos. 

 5.6.1 Cont. 
 
 
 
 
Figura 5.6.9 
Cuadro de diálogo Editar/eliminar 
(izquierda) 
 
Figura 5.6.10 
Información sobre el paciente 
(derecha) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5.7.0 
Funcionalidad 
DICOM 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.7.1 
Estructura del protocolo DICOM 
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Modalidad 
Para acceder a la configuración de la modalidad de los archivos DICOM, desde la barra de 
menú superior, seleccione «DICOM Utilities» (Utilidades de DICOM) y, a continuación, 
«DICOM Modality Setup» (Configuración de la modalidad DICOM). 

 

 

 

Es posible seleccionar el tipo de almacenamiento DICOM, ya sea Presentation (Presentación) 
o Processing (Procesamiento). El mismo cuadro de diálogo permite seleccionar la modalidad 
de imagen DICOM, ya sea Digital X-Ray (Radiografías digitales) o Digital X-Ray Mammography 
(Mamografía digital de rayos X). El usuario no puede definir Transfer Syntax (Sintaxis de 
transferencia) ni Value Representation (Representación de valores). Siempre se asignan para 
que sean META HEADER PRESENT (con etiquetas meta en el encabezado), LITTLE_ENDIAN 
(extremidad pequeña) y VR_IMPLICIT (realidad virtual implícita). 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Nota: Cuando las modalidades DICOM se han seleccionado, permanecen en efecto incluso 
después de que el software Vision se ha cerrado. Los ajustes de modalidad se almacenarán y 
permanecerán en la forma configurada hasta que se cambien de nuevo utilizando DICOM File 
Settings (Ajustes del archivo DICOM). Estos ajustes (Storage Type & Modality, Transfer Syntax 
y Value Representation) (Tipo y modalidad de almacenamiento, sintaxis de transferencia y 
representación de valores) serán efectivos para todas las funcionalidades DICOM Local Save 
(Almacenamiento local) o Print (Impresión). 

 5.7.0 Cont. 
 
 
 
Figura 5.7.2 
Menú Utilidades de DICOM 
 
 
 
 
 
 
 
 
 
 
 

Figura 5.7.3 
Ajustes de la modalidad DICOM  
Se muestran los ajustes 
predeterminados 
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Default DICOM Servers (Servidores DICOM predeterminados) 
Esta sección contiene la configuración para los servidores DICOM predeterminados y para 
automatizar algunos de los procesos al almacenar, imprimir o buscar servidores SACI y MWL. 

Las casillas de verificación «Enable Single-Click Auto Store» (Activar almacenamiento 
automático con un solo clic), «Print» (Imprimir) o «MWL Connection» (Conexión MWL) permiten 
al usuario almacenar o imprimir imágenes, o conectarse automáticamente al servidor MWL. Si 
usted utiliza un solo servidor SACI para esas acciones o la mayoría de su trabajo involucra un 
solo servidor SACI, marque la casilla deseada para automatizar esas acciones. 

«Enable Auto Search When Connecting to MWL Server» (Habilitar la búsqueda automática al 
conectarse al servidor MWL) le indicará a la aplicación que realice automáticamente una 
búsqueda con la configuración de búsqueda predeterminada al buscar los datos del paciente. 

El cuadro de diálogo «Auto close dialog after N seconds of successful transfer/printing» (Cierre 
automático después de N segundos de transferencia o impresión correcta) cerrará 
automáticamente el cuadro de diálogo DICOM Networking (Trabajo en red DICOM) 
transcurrido un número especificado de segundos. Si hubo un error en la transferencia o la 
impresión, el diálogo no se cerrará automáticamente. 

Al hacer clic en el botón DICOM Servers (Servidores DICOM), se abrirá el cuadro de diálogo 
DICOM Networking (Trabajo en red DICOM), donde el usuario podrá añadir, modificar o 
eliminar servidores DICOM. Véase la Figura 5.7.5. 

DICOM Save Local (Guardar como DICOM local) 
Para guardar la imagen actual en una unidad local o directorio, haga clic con el botón derecho 
en cualquier parte de la imagen. Esto mostrará el cuadro de diálogo que se muestra en la 
Figura 5.7.4 siguiente. Haga clic en «Save/Store current image» (Guardar/almacenar imagen 
actual) y, a continuación, en «As local 
DICOM image» (Como imagen 
DICOM local). Se abrirá el cuadro de 
diálogo Windows File Save (Guardar 
archivo de Windows) estándar. 
Busque o haga clic directamente en la 
carpeta deseada, introduzca el 
nombre del archivo y haga clic en 
Save (Guardar). 
  

PACS Store and PACS Print (Almacenamiento en SACI e 
impresión en SACI) 

El software Vision permite el almacenamiento en SACI (DICOM) y la impresión en SACI 
(DICOM). Estas opciones están disponibles en todo el software. Por ejemplo, si se selecciona 
el botón PACS Store 
(Almacenamiento en SACI), 
se podrá mostrar la siguiente 
ventana de diálogo de 
conexiones de red DICOM. 
Este cuadro de diálogo 
permite al usuario realizar un 
DICOM Store 
(Almacenamiento en 
DICOM), una DICOM Print 
(Impresión en DICOM) o Add 
(Agregar), Modify (Modificar) 
o Remove DICOM Network 
connections (Eliminar 
conexiones de red en 
DICOM) o Peripherals 
(Periféricos). 

 5.7.0 Cont. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.7.4 
Cuadro de diálogo Guardar 
imagen actual 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.7.5 
Cuadro de diálogo Conexiones de 
red DICOM 
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PACS DICOM Store (Almacenamiento en DICOM como SACI) 
El software Vision es compatible con el servicio DICOM 3.0 C-STORE. Esto permite enviar una 
imagen o una serie de imágenes (bajo un procedimiento específico) a un sistema de 
almacenamiento remoto compatible con la entidad de aplicación DICOM (AE), como, por 
ejemplo, SACI. Una vez más, la capacidad DICOM Store (Almacenamiento en DICOM) está 
prevista en todo el software Vision. Las modificaciones de Presentation (Presentación) y 
Processing (Procesamiento) se pueden realizar a través de DICOM Modality Setup 
(Configuración de la modalidad DICOM) bajo el menú Tools (Herramientas).  
Nota: En DICOM Store (Almacenar en DICOM), «SET FILM Attributes» (Ajustar atributos de la 
película) se muestran en gris.  
El usuario puede añadir una nueva configuración para una entidad de aplicación (AE) de 
DICOM remota a la que enviar la imagen o seleccionar una ya configurada, que se muestra en 
las conexiones DICOM Network (Red de DICOM) en el cuadro de diálogo DICOM Networking 
(Conexiones de red de DICOM). Haciendo doble clic (o un solo clic y presionando el botón 
Connect [Conectar]) en el icono de la entidad de aplicación (AE) de DICOM remota, el software 
Vision se conectará y establecerá una asociación DICOM con la AE remota seleccionada. Una 
vez que la asociación se haya establecido con éxito, la imagen se podrá enviar para su 
almacenamiento pulsando el botón Store (Almacenar). Después de seleccionar el botón Store 
(Almacenar), el software Vision enviará la imagen seleccionada a la AE de DICOM remota 
definida. Si la operación de almacenamiento tiene éxito, la AE de DICOM remota enviará una 
confirmación de recepción y almacenamiento de las imágenes. Si la operación falla, la AE de 
DICOM remota enviará un código de error indicando la razón del fallo. 
Una sola imagen también puede ser enviada para su almacenamiento haciendo clic en el botón 
derecho del ratón sobre la imagen en «miniatura» mientras está en el navegador de la base de 
datos y siguiendo el mismo procedimiento descrito anteriormente. Es posible enviar una Series 
(Procedure) (Serie [Procedimiento]) completa de imágenes para su almacenamiento. Esto se 
logra haciendo clic en el botón derecho del ratón en el nombre de la Series (Procedure) (Serie 
[Procedimiento]), que aparece en la pantalla del navegador de la base de datos y de nuevo, 
siguiendo el mismo protocolo descrito anteriormente. 

Add Session (Agregar sesión) 
El botón Add Session (Agregar sesión) abre el cuadro de diálogo Session (Sesión) a través del 
cual el usuario puede configurar una nueva conexión a una entidad de aplicación DICOM remota. 
Para crear una nueva configuración de conexión a una AE de DICOM remota, el usuario deberá 
tener disponible la siguiente información: Application Entity Title (AE Title) (Título de la entidad 
de aplicación [título AE]), la elección de «function to perform» (Función que se va a realizar) de 
DICOM/SACI, IP Address (dirección IP) y Port Number for the Sever (Número de puerto para 
el servidor [es decir, la impresora DICOM o el sistema SACI]). 
El título AE y el número de puerto del sistema del usuario (es decir, el cliente) también son 
obligatorios. Para crear una nueva configuración, rellene los campos de datos pertinentes y 
seleccione OK (Aceptar). 

Selección del comportamiento de la función de sesión 
predeterminada de DICOM/SACI 

Actualmente existen cuatro (4) tipos de funciones 
que una sesión DICOM puede representar por 
defecto. Estos se encuentran en la lista desplegable 
Function (Función) (cuadro combinado) que se 
muestra en la siguiente figura. También hay una lista 
a continuación: 

1. Una conexión DICOM/SACI GENERAL 
2. Una conexión ALMACENAMIENTO EN DICOM 
3. Conexión de una IMPRESORA DICOM 
4. Una conexión LISTA DE TRABAJO de modalidad 

 5.7.0 Cont. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.7.6 
Cuadro de diálogo Propiedades 
de la sesión 
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El propósito de la «función» DICOM es permitir la creación de una sesión o conexión (añadida) 
que permita que un «dispositivo» DICOM/SACI solamente pueda ser utilizado tal y como el 
usuario lo ha configurado para una categoría de función en particular. Una vez configurado, al 
visualizar o utilizar «DICOM Networking Dialog» (cuadro de diálogo Conexiones de red de 
DICOM) (véase la Figura 5.7.5 anterior), solamente estará «activo e iluminado» el icono 
correspondiente a la función elegida. Es decir, tendrá un color azul en lugar de un color 
«grisáceo». Por ejemplo, en la Figura 5.7.5 superior hay tres (3) iconos que representan, en 
orden: un almacenamiento en DICOM (DICOM Store 1), una impresión en SACI (DICOM Print 
1) y una lista de trabajo de modalidad (DICOM-MWL). Debido a que el botón DICOM Store 
(Almacenamiento en DICOM) fue elegido previamente, es el único que está activo (pantalla 
azul). Asimismo, funciona igual para los otros modos. 

Modify Session (Modificar sesión) 
El botón Modify Session (Modificar sesión) abre el cuadro de diálogo para la entidad de 
aplicación (AE) de DICOM seleccionada. En esta ventana, el usuario puede modificar la 
información del servidor y del cliente descrita en la descripción de Add Session (Agregar 
sesión). 

Remove Session (Eliminar sesión) 
El botón Remove Session (Eliminar sesión) elimina la configuración de la entidad de aplicación 
(AE) de DICOM seleccionada en el software Vision. Una vez eliminada, la configuración de la 
entidad de aplicación (AE) de DICOM no se podrá restaurar a menos que el usuario vuelva a 
introducir manualmente los datos necesarios mediante el botón Add Session (Agregar sesión). 
Se solicitará una confirmación de la acción; véase más adelante. 

 
 
 
 
 
 
 
 
 
 
 

 5.7.0 Cont. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.7.7 
Verificación de la eliminación de 
una conexión de red DICOM 
existente 
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Association (Asociación) 
El botón Association List (Lista de Asociaciones) abre el cuadro de diálogo Association 
(Asociación), representado abajo, mediante el cual el usuario puede editar los parámetros y 
protocolos utilizados por el software Vision cuando negocia una conexión con una entidad de 
aplicación (AE) de DICOM remota. Estas opciones solamente deben ser modificadas por un 
usuario avanzado que esté familiarizado con los protocolos de asociación de DICOM. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Film Attributes (Atributos de la película) 
Al seleccionar «SET DICOM PRINT FILM Attributes» (Ajustar atributos de la película de la 
impresora DICOM) en el menú «COMMAND» (Figura 5.7.9) aparecerá el cuadro de diálogo 
DICOM Printer Setup (Configuración de la impresora DICOM). Véase la Figura 5.7.10. En este 
cuadro de diálogo, el usuario podrá seleccionar varias opciones que rigen el formato de la 
película y la impresión. Al seleccionar Default (Predeterminado), se restauran todas las 
opciones predeterminadas. Las configuraciones de los ajustes se proporcionan a través de 
menús desplegables. Para aceptar la configuración modificada, seleccione OK (Aceptar). Para 
rechazar las opciones y salir de la ventana sin realizar ninguna modificación, seleccione Cancel 
(Cancelar). 

 
 

 5.7.0 Cont. 
 
 
 
 
 
 
Figura 5.7.8 
Ventana Asociación DICOM 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.7.9 
Establecer los atributos de la 
película de la impresora DICOM 
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PACS Print (Impresión en SACI) 
La opción PACS Print (Impresión en SACI) envía la imagen seleccionada a la impresora SACI 
DICOM seleccionada. La imagen se imprimirá de acuerdo con las opciones de formato de 
película y de impresión que se encuentran en el cuadro de diálogo Set Film Attributes 
(Establecer atributos de película) descrito anteriormente. Si el usuario inicia la impresión en 
SACI desde Image View (Vista de imagen), el nivel de la ventana será elegido desde la vista 
de imagen. Si la impresión en SACI se inicia desde el diálogo de base de datos, el nivel de 
ventana será el nivel de ventana por defecto calculado por el software Vision. 

 

Close (Cerrar) 
El botón Close (Cerrar) cierra el cuadro de diálogo DICOM Networking (Conexiones de red de 
DICOM) y devuelve al usuario al área desde la que se ejecutó el comando DICOM. Este 
comando también cerrará la conexión o asociación entre el software Vision y el dispositivo 
DICOM remoto, si se ha establecido una conexión. 

 

 5.7.0 Cont. 
 
Figura 5.7.10 
Cuadro de diálogo Configuración 
de la impresora DICOM 
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Descripción general 
Las anotaciones de usuario dentro del software Vision permiten aplicar a una imagen una 
«sobreimpresión» gráfica transparente, comúnmente llamada «anotaciones». Estas 
anotaciones adoptan la forma de texto, líneas, líneas de «forma libre» (curvas de Bezier), 
flechas, elipses y cuadros. Esto permite añadir información adicional y «marcadores» a la 
imagen, si se desea. Tenga en cuenta que todas las anotaciones se pueden activar o desactivar 
fácilmente; en otras palabras, se pueden mostrar u ocultar a voluntad. 

 

Funcionamiento 
Para comenzar a anotar, seleccione la herramienta Annotations (Anotaciones) del menú de 
la izquierda. Véanse las Figuras 5.4.1 y 5.8.1. Al abrir este cuadro de diálogo, el software 
pondrá inmediatamente al usuario en modo de diseño. También mostrará una «paleta de 
herramientas». Véase la Figura 5.8.2 siguiente.  
 

 

 

Al seleccionar Save (Guardar) o Cancel (Cancelar) en este cuadro de diálogo, se cancelarán 
las anotaciones anteriores o se guardarán las anotaciones actuales en la ventana. También le 
devolverá a usted al modo normal de obtención de imágenes. 

La paleta de herramientas consta de quince (15) opciones de herramientas que se muestran a 
continuación. Sin embargo, las herramientas pueden ser truncadas en función de las 
necesidades del usuario a las 8 herramientas más comunes, que se muestran en la fila superior 
del cuadro de diálogo.  

Tenga en cuenta que el comportamiento de la mayoría de estas opciones de herramientas 
implica utilizar el ratón para guiar la posición y la forma dinámica en pantalla. Los «clics» del 
ratón se utilizan para establecer la posición y la forma definitivas. El término «deslizar» implica 
mantener pulsado el botón izquierdo del ratón y mover el objeto por la pantalla. Si se suelta el 
botón izquierdo del ratón o se hace clic con el botón derecho del ratón, la anotación se colocará 
en una posición «permanente» o definitiva. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Partiendo de la parte superior izquierda de la figura anterior, a continuación se ofrece una 
descripción de cada opción de herramienta. 

 5.8.0 
Anotaciones del 
usuario 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.8.1 
Icono de Anotaciones 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.8.2 
Paleta de herramientas de diseño 
de anotaciones de usuario 
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• Herramienta Selection (Selección): se utiliza para seleccionar (resaltar) un objeto de la 
anotación actual. Haga clic y mantenga pulsado el botón izquierdo del ratón, que establece 
una posición inicial y, a continuación, mueva el ratón. Cualesquiera que sean las anotaciones 
que se encuentren dentro del cuadro que se está mostrando, serán seleccionadas para 
utilizarlas posteriormente. Para finalizar la operación, suerte el botón izquierdo del ratón. 

• Herramienta Line (Línea): dibuja una línea recta con esta opción. El comportamiento del 
ratón es el mismo que el de arriba. 

• Herramienta Box (Cuadro): dibuja un cuadro. El comportamiento del ratón es el mismo que 
el de arriba. 

• Herramienta Ellipse (and Circle) (Elipse [y círculo]): dibuja una elipse o un círculo. El 
comportamiento del ratón es el mismo que el de arriba. 

• Herramienta Arrow (Flecha): dibuja una línea con una flecha al final. El comportamiento 
del ratón es el mismo que el de la herramienta Line (Línea). 

• Herramienta Polygon Open Line (Línea abierta poligonal): dibuja líneas no rectas 
«segmentadas y abiertas». Haga clic con el botón izquierdo del ratón, mantenga pulsado el 
botón y dibújelo. Para fijar un segmento de línea, suelte el botón izquierdo. Repítalo cuantas 
veces lo desee. Haga clic con el botón derecho del ratón y la operación de la herramienta 
habrá finalizado. 

• Herramienta Text (Texto): crea un «cuadro de texto» donde se pueden escribir datos 
basados en texto. 

• Herramienta Ruler (Regla): crea un segmento de líneas paralelas. Muy parecida a la 
función Image Tools Ruler (Regla de herramientas de imagen). 

• Herramienta Polygon Closed Line (Línea cerrada poligonal): dibuja líneas no rectas 
«segmentadas y cerradas». Haga clic con el botón izquierdo del ratón, mantenga pulsado el 
botón y dibújelo. Para fijar un segmento de línea, suelte el botón izquierdo. Repítalo cuantas 
veces lo desee. Haga clic con el botón derecho del ratón y la operación de la herramienta 
habrá finalizado. 

• Herramienta Curved Open Line (Línea curva abierta): dibuja líneas curvas «abiertas y 
segmentadas» (Curvas de Bezier). Haga clic con el botón izquierdo del ratón, mantenga 
pulsado el botón y dibújelo. Para fijar un segmento de línea curva, suelte el botón izquierdo. 
Repítalo cuantas veces lo desee. Haga clic con el botón derecho del ratón y la operación de 
la herramienta habrá finalizado. 

• Herramienta Curved Closed Line Tool (Línea curva cerrada): dibuja líneas curvas 
«segmentadas y cerradas». (Curvas de Bezier). Haga clic con el botón izquierdo del ratón, 
mantenga pulsado el botón y dibújelo. Para fijar un segmento de línea curva, suelte el botón 
izquierdo. Repítalo cuantas veces lo desee. Haga clic con el botón derecho del ratón y la 
operación de la herramienta habrá finalizado. 

• Herramienta Text «Balloon» (Globo de texto): crea un cuadro de texto con un segmento 
de línea que sobresale de una esquina del cuadro de texto. Esto se puede utilizar para 
«enlazar» texto a algo que esté en la imagen que usted haya obtenido. 

• Segmented Ruler (Regla segmentada): dibuja líneas no rectas paralelas «abiertas y 
segmentadas». Haga clic con el botón izquierdo del ratón, mantenga pulsado el botón y 
dibújelo. Para establecer un segmento de líneas paralelas, suelte el botón izquierdo. Repítalo 
cuantas veces lo desee. Haga clic con el botón derecho del ratón y la operación de la 
herramienta habrá finalizado. La longitud de todos los segmentos de líneas paralelas se 
muestra al final de la regla. Útil para una estimación aproximada de la periferia de un objeto 
o paciente. 

• Herramienta Protractor (Escuadra): dibuja un ángulo en la pantalla y proporciona el grado 
del ángulo. Igual que una escuadra. 

• Herramienta Orthogonal Ruler (Regla ortogonal): Proporciona dos (2) líneas paralelas 
que son ortogonales entre sí.  

 5.8.0 Cont. 
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Modo de diseño y menú contextual del ratón 
 
En el modo de diseño de anotaciones de usuario, pero no en un modo de operación específico, 
se puede hacer clic con el botón derecho del ratón y obtener un menú contextual. Véase más 
abajo. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Desde estos menús contextuales se pueden realizar muchas configuraciones específicas. 
 
Nota: Si un elemento parece demasiado pequeño para leerlo o verlo correctamente, usted lo 
podrá cambiar desde los menús contextuales del ratón mostrados más arriba. De forma 
alternativa, podrá elegir hacer zoom en la imagen utilizando la herramienta Dynamic Zoom 
(Zoom dinámico). Esto ampliará la imagen y usted debería poder ver claramente cualquier 
anotación. 
 
 

Mostrar u ocultar las anotaciones 
 
El botón Toggle Annotations (Alternar anotaciones), que se muestra en la 
Figura 5.8.4, permite a los usuarios activar y desactivar rápidamente las 
anotaciones. Por defecto, las anotaciones estarán activadas. El botón se encuentra 
en el menú del lado derecho, cerca de la esquina superior derecha. 
 
 
 

 5.8.0 Cont. 
 
 
 
 
 
Figura 5.8.3 
Clic con el botón derecho del 
ratón en el menú contextual 
(solamente durante el modo de 
diseño de las anotaciones de 
usuario) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 5.8.4 
Opción mostrar/ocultar para las 
anotaciones del usuario 
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El submenú «Help» (Ayuda), véase la Figura 5.9.1, se encuentra en la barra de menú superior 
y permite un acceso rápido al «User’s Manual» (Manual de usuario) y a «About Vision» (Acerca 
de Vision) de Faxitron Path. Consulte la Sección 5.10.0 y la Figura 5.10.1. 
 
 
 
 

 5.9.0 
Acerca de la Ayuda 
 
 
Figura 5.9.1 
Cuadro de diálogo Ayuda en línea 
 
 
 
 
 
 

 
 
El botón «About Vision» (Acerca de Vision) abre un cuadro de diálogo que muestra la versión 
del software Vision, la fecha de la propiedad intelectual y la información del sistema. 

 

 

 5.10.0 
Acerca del 
software Vision 
 
Figura 5.10.1 
Cuadro de diálogo con 
información acerca de Vision 
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Requisitos | Cumplimiento de Faxitron Path 
 
Límites de emisión 
La radiación de rayos X emitida por la unidad Faxitron Path no excede una exposición de 
0,1 mili-Roentgens (mR) por hora en cualquier punto a 5 centímetros (cm) (2 in) fuera de la 
superficie externa. Para los países que exigen valores de emisión medidos a 10 cm de la 
superficie exterior, la radiación no supera los 0,1 mR por hora a 10 cm. 
 
Enclavamientos de seguridad 
El sistema Faxitron Path de radiografías digitales de especímenes tiene dos enclavamientos 
de seguridad en la puerta de los especímenes. 
 
Botón Start (Inicio) 
Tras la interrupción de la generación de rayos X por los enclavamientos de seguridad, el botón 
Start (Inicio) del panel frontal reanudará la generación de rayos X cuando esté listo. 
 
Control accionado por llave 
El interruptor de cerradura con llave situado en el panel frontal requiere que se inserte y se 
gire una llave en el sentido de las agujas del reloj hasta la posición de las 3 para suministrar 
energía al sistema de armario. La llave se mantiene fijada en la posición «ON». 
 
Botón Emergency Stop (Parada de emergencia) 
En el panel frontal, Faxitron Path incluye el botón Emergency Stop (Parada de emergencia) 
para detener la generación de rayos X. Esto se suma a los enclavamientos de seguridad de 
las puertas del sistema. 
 
Indicadores de generación de rayos X 
El Faxitron Path tiene un indicador luminoso de rayos X en el panel frontal y en la interfaz 
gráfica de usuario, y produce también un tono audible cuando se generan los rayos X. 
 
Potencias nominales 
Máximo de 100-240 VCA, 50/60 Hz, 200 W 
 
Potencia calorífica 
Máximo de 527,5 kJ/h (500 BTU/h) 
 
LOCALIZADOR LÁSER 
El Faxitron Path utiliza un par de líneas generadas por láser que facilitan el posicionamiento 
de las muestras en el centro del campo de generación de imágenes.  
 
Parámetros del láser 
Cumple con la norma IEC 60825-1:2007 
Producto láser de clase 2 
Longitud de onda: 670 nm 
Potencia máxima: 2 mW 
Anchura de línea: típicamente, 1 mm 
Divergencia del rayo: típicamente, 85° 
 
Los láseres no requieren montaje. 
 
No hay un proveedor autorizado de mantenimiento para los láseres. El mantenimiento de los 
láseres debe llevarlo a cabo únicamente un representante autorizado de Hologic. 
 
PARÁMETROS ELÉCTRICOS DEL LÁSER 
Tensión de funcionamiento:    Rojo, 3-6VDC 
                                                Negro,  Tierra 
Corriente de funcionamiento:  típicamente, 50 mA 
                                                máxima, 80 mA 
 
 

 6.1.0 
Requisitos de 
cumplimiento y 
medidas de 
seguridad 
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PRECAUCIONES:  
RADIACIÓN LÁSER DE CLASE 2 CUANDO LA PUERTA ESTÁ ABIERTA. NO MIRE 
FIJAMENTE AL RAYO.  
 
Los rayos láser pueden provocar daños en los ojos, NO mire a la abertura del láser mientras 
este esté en funcionamiento. 
 
Tenga en cuenta que la luz láser también puede ser peligrosa si se refleja en una superficie 
similar a un espejo. 
 
Para obtener más información acerca de los láseres, consulte la NORMA NACIONAL 
NORTEAMERICANA PARA EL USO SEGURO DE LÁSERES ANSI Z1 36.1, disponible a 
través del Laser Institute of America (teléfono 407-380-1553). 
 
NOTA: Las aberturas del láser se encuentran en la parte superior del compartimento de rayos X. 
 
 
 
Etiqueta de PRECAUCIÓN del láser: en la equina superior derecha de la puerta. 

 
 
 
 
 

 6.1.0 Cont. 
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Versión de DICOM 
 
Hologic utiliza el último estándar DICOM: 
Imagenología Digital y Comunicaciones en Medicina (DICOM) v3.0, desarrollado por ACR-
NEMA, versión definitiva, agosto de 1993. 
 
Y cumple el estándar:  
NEMA PS 3.1‑3.20 (2016), Equipo de Imagenología Digital y Comunicaciones en Medicina 
 
 
Clases de almacenamiento 
 
FAXITRON_DR cumple la norma relativa a la siguiente clase SOP (par servicio-objeto) de 
DICOM V3.0 como SCU (usuario de clase de servicio). 
 
Clase SOP como SCU 

 
Clase SOP UID (identificador único) de clase SOP 

SOP de almacenamiento de imágenes de 
radiografías computarizadas 

1.2.840.10008.5.1.4.1.1.1 

Presentación del almacenamiento digital de 
imágenes realizadas con rayos X 

1.2.840.10008.5.1.4.1.1.1.1 

Procesamiento de imágenes digitales realizadas 
con rayos X 

1.2.840.10008.5.1.4.1.1.1.1.1 

Presentación del almacenamiento de imágenes 
digitales de mamografías realizadas con rayos X 

1.2.840.10008.5.1.4.1.1.1.2 

Procesamiento de imágenes digitales de 
mamografías realizadas con rayos X 

1.2.840.10008.5.1.4.1.1.1.2.1 

Consulta o recuperación de la información raíz 
del estudio. Modelo -FIND 

1.2.840.10008.5.1.4.1.2.2.1 

Consulta o recuperación de la información raíz 
del paciente. Modelo -FIND 

1.2.840.10008.5.1.4.1.2.1.1 

Modelo -FIND de información de las listas de 
trabajo de las modalidades 

1.2.840.10008.5.1.4.31 

Almacenamiento de la presentación de las 
copias digitales en escala de grises 

1.2.840.10008.5.1.4.1.1.11.1 

 
 

Para conocer más detalles, consulte en su totalidad la Declaración de Conformidad de 
DICOM, que está almacenada en el sistema. El archivo está en C:\Faxitron, y hay un acceso 
directo en el escritorio.  
 
Si la necesita, puede solicitar a Hologic una copia de la declaración de conformidad de 
DICOM. 

 
 
 
 

 6.2.0 
Estándar DICOM 
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Mantenimiento 
 
En los equipos Hologic no hay piezas que se puedan reparar. Para recibir asistencia técnica, 
póngase en contacto con el representante autorizado de Hologic.  
 
EE. UU.: +1.877.371.4372 

Europa: +32 2 711 4690 

Asia: +852 37487700 

Australia: +1 800 264 073 

Resto del mundo: +1 781 999 7750 

Correo electrónico: BreastHealth.Support@hologic.com 

 
 
Solución de problemas 
 
El ordenador o el sistema no se encienden 
El ordenador o el sistema de rayos X no están recibiendo alimentación eléctrica.  
Compruebe que el sistema esté encendido y que la regleta esté enchufada y encendida. 
 
La luz LISTO no permanece encendida 
Se presionó el botón ANTES de que el software Vision estuviera en marcha o antes de que 
preparara el sistema de rayos X para obtener una imagen. Consulte la sección Inicio rápido. 
 
En la imagen parece como si en la radiografía hubiera otro objeto 
Compruebe si durante la calibración había algún objeto en el armario de rayos X. Retire 
cualquier objeto y repita la calibración. 
 
La imagen tiene mala calidad  
Compruebe que los valores de intensidad de la imagen (I (x,y)) que se encuentran en la 
esquina inferior derecha de la ventana de visualización de la imagen estén cerca de 
10 000 UAD, que el objetivo AEC predisparado esté también ajustado a 10 000 UAD y que el 
modo de exposición esté seleccionado como Auto kV/Auto Time (kV automático/tiempo 
automático). Si fuera necesario, repita el procedimiento de obtención de imágenes. 
 
 
 
Ciberseguridad 
Si se produce un evento de ciberseguridad, desconecte de la red el sistema y póngase 
inmediatamente en contacto con Hologic. Trabajaremos con el departamento de TI del centro 
para resolver el problema. 
 
Un evento de ciberseguridad puede detectarse de varias maneras: 

• El funcionamiento y/o la conexión de red son más lentos de lo normal. 

• En el navegador de Internet aparecen ventanas emergentes sospechosas o la 
página de inicio ha cambiado. 

• La(s) contraseña(s) ya no funciona(n). 

• En el menú de inicio o en la bandeja del sistema hay programas desconocidos. 

• Los datos se han perdido, dañado o alterado. 

 
 
 

 7.1.0 
Mantenimiento y 
resolución de 
problemas  
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Este documento proporciona un programa de pruebas y mantenimiento para Faxitron Path. 
Para garantizar que el generador de rayos X Faxitron siga funcionando con un rendimiento 
óptimo, se recomienda encarecidamente que el mantenimiento y las pruebas descritas en esta 
sección se realicen en los intervalos de tiempo indicados. 

 8.0.0 
Mantenimiento 
 

 
Advertencia: las muestras que contienen tejidos pueden albergar agentes 
infecciosos que son peligrosos para la salud. Siga los correspondientes 
procedimientos de bioseguridad; cuando manipule especímenes de tejido o los 
materiales con los que entren en contacto, utilice guantes. 
  
Limpie periódicamente el interior del armario con alcohol isopropílico al 70-90 % o hipoclorito 
de sodio diluido (la lejía doméstica al 5,25 %-6,15 % diluida en la proporción 1:500 ofrece la 
concentración adecuada). Asegúrese de que el área de especímenes, marcada en la base de 
la cámara, esté bien limpia. 
 
No utilice acetona ni otros disolventes agresivos en la ventana de la puerta del compartimento 
de rayos X. 
 

  
8.1.0 
Interno 

 
Limpie periódicamente las superficies exteriores con alcohol isopropílico, hipoclorito de sodio, 
o agua con jabón suave (consulte las concentraciones adecuadas en la sección 8.1.0). No 
empape ni inunde las superficies, ni utilice abrasivos que puedan rayarlas. No permita que la 
humedad entre en contacto con ninguno de los componentes eléctricos del sistema. Para 
verificar que no deterioran el acabado, pruebe los productos de limpieza en un área pequeña 
y poco visible de las cubiertas metálicas y de plástico. 
 

  
8.2.0 
Exterior 

 
A excepción de los cables y fusibles externos, el sistema no tiene componentes que el usuario 
pueda reemplazar. A continuación, se enumeran los artículos que se pueden pedir para que 
personal de Hologic o representantes autorizados los sustituyan. 
 

• Detector de rayos X digital 

• Tarjeta de interfaz PCIe 

• Ordenador, monitor, ratón y teclado 

• Placa de circuito impreso del controlador  

• Tubo de rayos X y fuente de alimentación de alta tensión 

• Fuente de alimentación de baja tensión 

 

  
8.3.0 
Piezas sustituibles 

 
• Objetivo acrílico de dispersión (~6 mm [0,25 in] y ~24 mm [1 in] de grosor) 
• Fantoma ACR (n.º de referencia de Nuclear Associates 18-250) 
• Dosímetro de cámara de ionización, modelo 451B-DE-SI-RYR de Inovision o similar 
• Jarra de plástico con capacidad para 4 litros (1 galón) de agua 
 

  
8.4.0 
Materiales 
necesarios 

 
En las siguientes referencias se proporciona más información sobre los procedimientos de 
seguridad del software que se describen en este documento. 
 
Seguridad y ciberseguridad 
En caso necesario, se proporcionará cualquier actualización de software o firmware distribuida 
desde el último mantenimiento en que se haya resuelto un problema de seguridad.  
 
El firmware está codificado de forma fija en la placa de control, por lo que, en caso de que sea 
necesaria una actualización del mismo, deberá sustituirse la placa de circuito impreso del panel 
de control.  

  
8.5.0 
Documentos de 
referencia e 
información sobre 
la versión 
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A continuación, se incluyen las definiciones de los términos tal y como se aplican en este 
Programa de mantenimiento. 
 
AEC: Automatic Exposure Control (control automático de la exposición): interrupción de los 
rayos X llevada a cabo por el ordenador cuando la señal suficiente alcanza el sensor. 
 
Ampliación: movimiento del objeto lejos del sensor y hacia la fuente de rayos X para ampliar 
la imagen del objeto en el detector. 
 
Campo plano: correcciones de ganancia y compensación que se realizan píxel a píxel. La 
ganancia y compensación de cada píxel son diferentes, por lo que debe calibrarse. 
 
Contraste: diferencia porcentual entre la intensidad del objeto y la intensidad del fondo. 
 
Corriente oscura: señal térmica que se genera en el sensor; (casi) lineal con el tiempo. 
 
Fantoma ACR: fantoma acreditado por el American College of Radiology (Colegio de 
Cardiología de los Estados Unidos). 
 
Función de transferencia de modulación, (MTF, por sus siglas en inglés): medida del 
contraste y la resolución de un sistema de obtención de imágenes. 
 
Pares de líneas por milímetro: número de porciones llenas y vacías alternas. Por ejemplo, 
10 lp/mm significa => {vacía/llena} {vacía/llena}... 10 veces en un milímetro. 
 
Radiografía de un espécimen: obtención de imágenes de rayos X de una porción de tejido 
extraída del cuerpo. 
 
ROI: región de interés. Por norma general, una subregión específica de una imagen. 
 
Ruido de lectura: medida del ruido RMS en una exposición oscura de 0 segundos (sin señal). 
 
SID: distancia de la fuente a la imagen; distancia desde la fuente de rayos X al detector. 
 
UAD: unidades analógico-digitales.  

 8.6.0 
Definiciones 

 
El mantenimiento periódico debe realizarse anualmente para garantizar que el sistema 
Faxitron Path siga funcionando de forma óptima a lo largo del tiempo. Dicho mantenimiento 
periódico incluye la comprobación de lo siguiente: 

• enclavamientos e indicadores de seguridad, Sección 8.8.0; 

• prueba de fantoma ACR (verifica el rendimiento de la cámara), Sección 8.8.1; y 

• estudio radiográfico, Sección 8.8.2. 

 

Recomendamos realizar estos procedimientos de forma anual; no obstante, las normativas 
gubernamentales podrían requerir programas de mantenimiento más frecuentes.  

  
8.7.0 
Mantenimiento 
periódico 
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Enclavamientos, luces, mensajes de error; a realizar anualmente. 
 
Si fuera necesario, imprima esta página para utilizarla como referencia. 

Anote los resultados en el apartado «Enclavamientos e indicadores de seguridad» del Registro 
del mantenimiento periódico de Faxitron Path que se encuentra al final de la sección. 

 

 8.8.0 
Enclavamientos e 
indicadores de 
seguridad 

1. El sistema debe estar encendido. El interruptor de cerradura con llave debe estar en la 
posición de las tres y la llave debe estar fijada. 

 
2. Compruebe que el LED de encendido esté iluminado. Ningún otro LED debería estar 

iluminado en ese momento.  
 
3. Compruebe que la pantalla LCD se ilumine y muestre «System Idle» (Sistema inactivo), y 

que no haya ningún otro mensaje, como «Door Open» (Puerta abierta).  
 
4. Abra la puerta de los especímenes. La pantalla LCD mostrará el mensaje «Door Open» 

(Puerta abierta). Cuando se cierre la puerta, el mensaje debería desaparecer. 
 
5. Encienda el ordenador y el monitor. El software Vision debería iniciarse automáticamente. 

Si no se inicia automáticamente, haga doble clic en el icono del software Vision para iniciar 
el software de obtención de imágenes. Si, al hacerlo, se inicia una calibración, permita que 
se realice por completo.  

 
6. A continuación, haga clic en el botón Start Procedure (Iniciar procedimiento) y, después, 

en el botón Patient Data (Datos del paciente), y seleccione el botón Enter Manually 
(Introducción manual) para acceder a la pantalla de entrada del paciente. Cumplimente 
todos los campos marcados con un asterisco (*) y haga clic en el botón Accept (Aceptar). 
Esto permitirá que se lleve a cabo una exposición. 

 
7. Compruebe que el LED «Ready» (Listo) esté encendido. En la pantalla LCD también se 

mostrará el mensaje «Ready» (Listo). 
 
8. Pulse el botón verde «X-ray» (Rayos X) que está en la parte frontal del Faxitron Path. El 

sistema debería comenzar una exposición a los rayos X. Asegúrese de que en la pantalla 
LCD aparezca una barra indicadora de la exposición, así como los kV y el tiempo de la 
misma. Compruebe también que el LED «X-Ray On» (Rayos X encendidos) se encienda. 
Además, durante la exposición, debería escucharse un pitido breve una vez por segundo. 
Espere a que la exposición finalice y asegúrese de que la imagen aparezca en la pantalla 
del ordenador. 

 
9. Vuelva a pulsar el botón verde para iniciar otra exposición. Mientras se esté produciendo 

la exposición, pulse el botón rojo «Stop» (Detener). La exposición debería detenerse 
después de pulsarlo durante 2 segundos. El timbre dejará de sonar para indicar que la 
exposición se ha detenido. El software mostrará errores de interrupción, lo que es 
perfectamente normal. Al eliminarlos, se podrán volver a realizar radiografías. 

 
10. Vuelva a pulsar el botón verde para iniciar la exposición. En esta ocasión, abra la puerta 

de los especímenes. Esto debería soltar los interruptores de seguridad y forzar la parada 
de la exposición. Es posible que el software muestre errores, elimínelos.  
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Fantoma ACR (solo insertos de cera); a realizar anualmente. 
 
Si fuera necesario, imprima esta página para utilizarla como referencia. 

Anote los resultados en el apartado «Prueba de fantoma ACR» del Registro del mantenimiento 
periódico de Faxitron Path que se encuentra al final de la sección. 

 
El usuario debe estar familiarizado con el uso de Faxitron Path y conocer los procedimientos 
para tomar radiografías. Complete los procedimientos de configuración y asegúrese de que la 
cámara esté calibrada (tenga en cuenta los kV y el tiempo de calibración). Introduzca los datos 
del paciente y tome una fotografía de una porción del inserto de cera del minifantoma ACR 
que se muestra en la Figura 8.1 NOTA: Para realizar la imagen deberá retirarse el inserto de 
cera de su soporte acrílico. 
 
 
 
 
El minifantoma ACR contiene doce 
objetos: cuatro masas, cuatro fibras y 
cuatro grupos de calcificaciones 
(manchas). Por su parte, cada grupo de 
calcificaciones contiene seis 
calcificaciones o manchas diferentes. 
Todas las masas, fibras y calcificaciones 
deben ser visibles. 
 
 
 
 
 
 
Nota: El último grupo de calcificaciones 
podría no ser visible en esta imagen. 
 
 
 
 
REQUISITOS DE ACEPTACIÓN 
 
1. Configure el sistema para tomar una imagen manual del inserto de cera del minifantoma 

ACR. Ajuste los kV y el tiempo según lo observado durante la calibración. 

2. Asegúrese de que el fantoma esté limpio y sin residuos. 

3. Coloque el inserto de cera directamente en la base del compartimento, en el centro del área 
de imagen. No utilice bloques atenuadores. 

4. Encienda los rayos X y espere a que se complete todo el proceso y se muestre la imagen. 

5. Al principio de mostrarse la imagen, es posible que no todos los objetos del fantoma sean 
visibles. Ajuste los niveles de contraste y de brillo según sea necesario para obtener la mejor 
imagen posible. 

6. Una vez corregida la imagen, todos los grupos de objetos deberían ser visibles. 

7. Anote los resultados en el Registro del mantenimiento periódico. 

 
 

 8.8.1 
Prueba de fantoma 
ACR 
 
 
 
 
 
 
 
 
Figura 8.1 
Imagen de rayos X típica del 
inserto de cera del minifantoma 
ACR (n.º de referencia de 
Nuclear Associates 18-250) 
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Estudio radiográfico; a realizar, como mínimo, anualmente, o en caso de que el 
dispositivo se caiga o sufra algún daño. 

Puede imprimir las siguientes páginas para utilizarlas como instrucciones para realizar el 
estudio radiográfico. 

Anote los resultados en el apartado «Estudio radiográfico» del Registro del mantenimiento 
periódico de Faxitron Path que se encuentra al final de esta sección. 

Para garantizar que las emisiones de radiación estén dentro de los límites necesarios, el 
fabricante recomienda que se realice al menos un estudio radiográfico al año*. Si la máquina 
sufre alguna clase de daño tras su instalación, deberá realizarse un estudio radiográfico antes 
de volver a ponerla en funcionamiento en las instalaciones. 

 

Herramientas necesarias 
• Dosímetro radiográfico con fuente de comprobación (se recomienda un dosímetro de 

cámara de ionización como el modelo 451B de Inovision; el dispositivo incluye la fuente de 
comprobación).  

• Jarra de plástico con capacidad para 4 litros (1 galón) de agua. 

 

Comprobación del funcionamiento del dosímetro 
1. Fecha de calibración: compruebe que la calibración del dosímetro esté actualizada. 

2. Revisión de las pilas: compruebe el estado de las pilas. Si fuera necesario, reemplácelas. 

3. Revisión del funcionamiento: (y de la fuente de comprobación, si está disponible). Nota: 
Los siguientes pasos solo se aplican al modelo 451B de Inovision o a dosímetros de 
cámara de ionización similares. Para otros medidores, siga las instrucciones del 
fabricante. 

• Abra el protector beta deslizante situado en la parte inferior del dosímetro. 

• Coloque el medidor sobre la fuente de comprobación y monitorice durante 
30 segundos. 

• La lectura del dosímetro debería encontrarse dentro de la tolerancia indicada en la 
etiqueta de calibración. 

• Anote la lectura en el Registro del mantenimiento periódico. 

• Cierre el protector beta del medidor. 

 

 

 

Notas importantes: 
1. Todas las medidas de radiación se realizan con el dosímetro radiográfico a no más de 5 cm 

(2 in) de distancia de la superficie de la unidad Faxitron Path. 

2. Al anotar las medidas de radiación, es posible que deba multiplicarlas por 0,1 para convertir 
la lectura de µSv/h a mR/h. Por ejemplo, 12 µSv/h equivalen a 1,2 mR/h. 

 

 

 

 

 

 8.8.2 
Estudio 
radiográfico 
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Procedimiento de estudio radiográfico 
 
1. Haga una lectura de la radiación de fondo (con el medidor hacia el centro de la habitación) 

y anote el resultado. 

2. Configure el sistema para tomar una imagen manual. 

a. Haga clic en el botón Device Panel (Panel del dispositivo) y seleccione Full Manual 
(Totalmente manual).  

b. Arrastre los controles deslizantes de los kV y el tiempo tan a la derecha como es 
posible para ajustarlos al máximo. 

c. Haga clic en el botón «SET» (AJUSTAR). 

3. Compruebe que el LED «Ready» (Listo) esté encendido. 

4. Abra la puerta del compartimento. Coloque la jarra de plástico con 4 litros (1 galón) de agua 
en el área de imagen de la base del compartimento y cierre la puerta. 

5. Pulse el botón «START» (INICIAR) y mida las emisiones de radiación en la parte superior, 
frontal, posterior y en ambos laterales del armario. Analice lentamente toda la superficie con 
el medidor. Cada análisis debería tardar 1 o 2 exposiciones a los rayos X. Nota: Para 
completar el estudio completo, tendrá que iniciar los rayos X en varias ocasiones. 

6. Anote las lecturas de cada lugar de la prueba. 

7. Si cualquiera de las lecturas es superior al límite de radiación de Hologic de 0,1 mili-
Roentgens (mR) por hora (1,0 µSv/h) en cualquier punto a 5 centímetros (cm) de distancia 
de la superficie exterior (*), póngase en contacto con un representante de Hologic para 
discutir las opciones de reparación. 

(*) El límite máximo fijado por el CDRH de la FDA de EE. UU. para los armarios de 
rayos X es de 0,5 mR/h a 5 cm (2 in) de las superficies externas. Si se utiliza en otro 
país, consulte los límites oficiales vigentes para los equipos de radiografía para el 
diagnóstico in vitro tipo armario. 

En algunos países, los puntos para la prueba deben situarse a 10 cm de las superficies 
externas. En este caso, a 10 cm de las superficies externas, la lectura de la emisión de 
radiación de los sistemas debería ser inferior a 0,1 mR/h. 

8. Retire la jarra de agua del compartimento de rayos X.  

9. Si el sistema está sobre una mesa o si hay personal en el piso inferior a donde este se usa, 
deberá realizarse un estudio de la parte inferior del armario de rayos X. Compruebe que no 
haya nada en el compartimento de rayos X, inicie los rayos X y analice la parte inferior del 
compartimento. Anote la lectura. 

 

 

 

 

 8.8.2 Cont. 
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Registro del mantenimiento periódico de Faxitron Path  

N.º de serie del sistema: ______  N.º de serie de la cámara: ____   

 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

El mantenimiento periódico identificado anteriormente fue completado por: _________________________  
 
Fecha de realización: ____________  Firma: __________________________________________________  

Enclavamientos e indicadores de seguridad (Sección 8.8.0) 

Satisfactorio:                Insatisfactorio:                      Iniciales: _______  Fecha: _____________  

En caso de resultado insatisfactorio, indique las razones y las medidas emprendidas para corregir el fallo. 

 ________________________________________________________________________________  

 ________________________________________________________________________________  

 ________________________________________________________________________________  

Iniciales: ___________  Fecha: ______________  
 
 Prueba de fantoma ACR (Sección 8.8.1) 

Número de objetos observados:  Masas: ______  Fibras: _____  Grupos de calcificación: ___  

Satisfactorio:                Insatisfactorio:                      Iniciales: _______  Fecha: _____________  

En caso de resultado insatisfactorio, indique las razones y las medidas emprendidas para corregir el fallo. 

 ________________________________________________________________________________  

 ________________________________________________________________________________  

 ________________________________________________________________________________  

Iniciales: ___________  Fecha: ______________  
 
 Estudio radiográfico (Sección 8.8.2) 

Lectura de la radiación en:        mR/h µSv/h Fuente de comprobación:         De fondo: ___   

Parte frontal: _______ Lado derecho: _________  Parte superior: ______  

Parte posterior: _____ Lado izquierdo: ________  Parte inferior: _______  

Satisfactorio:                Insatisfactorio:                      Iniciales: _______  Fecha: _____________  

En caso de resultado insatisfactorio, indique las razones y las medidas emprendidas para corregir el fallo. 

 ________________________________________________________________________________  

 ________________________________________________________________________________  

 ________________________________________________________________________________  

Iniciales: ____________  Fecha: ______________  
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Revisión Fecha Descripción de la modificación Creador Aprobado 
por 

1.0 29 de junio 
de 2012 

Publicación inicial. Ciaran 
Purdy 

Doug 
Wiegman 

1.1 28 de enero 
de 2016 

Actualizaciones menores. Mikhail 
Viznyuk 

Ciaran 
Purdy 

2.0 24 de 
octubre de 

2018 

Actualización de las imágenes del software para la 
publicación de Metro. 
Incorporación de sección de revisiones. Renumeración 
de páginas en las secciones. Eliminación de índice. 

Cary 
McLaughlin 

Ciaran 
Purdy 

021 16 de julio 
de 2019 

• Revisiones menores en la Sección 0. 
• En la Sección 1, se ha actualizado el representante 

autorizado en la UE. 
• Cambios en la Sección 2: 
o Incorporación de Advertencias, Conexiones 

interoperativas y Ciberseguridad. 
o Eliminación de la «Secuencia de puesta en 

marcha».  
o Eliminación del «Procedimiento para el apagado».  
o Incorporación de información sobre protección 

radiológica. 
• Eliminación de información innecesaria de la Sección 

3. 
• Reorganización de la Sección 4 para mejorar la 

fluidez y eliminación de información innecesaria. 
• Sección 5: para que la progresión fuera más lógica, 

se han reorganizado numerosas subsecciones. 
o Se ha revisado la secuencia de la puesta en 

marcha. 
o Se ha revisado la sección sobre calibración de la 

cámara. 
o Se ha cambiado el flujo de datos del paciente. 
o Se ha revisado la claridad de varias subsecciones. 

• Incorporación de información sobre ciberseguridad. 
• Cambios en la Sección 8: 
o Actualización de la información sobre limpieza en 

los apartados 8.1.0 y 8.2.0. 
o Corrección de las referencias en 8.7.0. 
o Actualización y revisión de los apartados 8.8.0, 8.8.1 

y 8.8.2 sobre mantenimiento para una mayor 
claridad. 

o Eliminación de las hojas de registro de 
mantenimiento de 8.8.0, 8.8.1 y 8.8.2. 

o Creación de una nueva hoja de registro única. 

Alan 
Mihalko 

S. 
Howerton  
J. Mudd  
D. Canny  
D. Saraiya  
R. Nash  
T. Longo  
M. Fremont  
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022 12-3-2019 Se ha actualizado el branding 
Dhaval 
Saraiya 

C. Purdy 
D. Saraiya 
R. Nash 
M. Fremont 
S. Howerton 
T. Longo 

023 Julio de 
2021 

Actualización del fabricante y del representante 
de la UE 
Se ha añadido al patrocinador de Australia 
Se ha actualizado la información de contacto relativa 
al mantenimiento 

Alan 
Mihalko 

Consulte 
CCB 

024 Agosto de 
2021 

Se ha añadido el símbolo «Consult IFU» (Consulte las 
instrucciones de uso) y la dirección/enlace a la web de 
los «package-inserts» (prospectos) 
Se ha añadido la información de contacto de Brasil 

Alan 
Mihalko 

Consulte 
CCB 

025 Agosto de 
2021 

Se ha eliminado la información del «Brazilian Contact» 
(Contacto en Brasil) 
Se ha actualizado el logotipo «Faxitron Path», 
de «TM» a  

Alan 
Mihalko 

Consulte 
CCB 

 




